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Introduction to Oracle Forms Developer 
and Oracle Forms Services
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Objectives

After completing this lesson, you should be able to do 
the following:
• Define grid computing 
• Explain how Oracle 10g products implement grid 

computing 
• Describe the components of Oracle Application 

Server 10g and Oracle Developer Suite 10g
• Describe the features and benefits of Oracle 

Forms Services and Oracle Forms Developer
• Describe the architecture of Oracle Forms 

Services
• Describe the course application
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Internet Computing Solutions

Application Type
and Audience

Enterprise applications,
Business developers

Java components,
Component developers

Product
Approach

Repository-based
modeling & generation,

Declarative

Oracle
Products

Oracle Designer,
Oracle Forms Developer, 
& Oracle Forms Services

Two-way coding,
Java and JavaBeans

Oracle JDeveloper 
Oracle Application Server 10g

Browser-based,
Dynamic HTML

Self-service applications &
content management,
Web site developers

Oracle Portal
Oracle Database Server

Dynamic Web
reporting, Drill, 

Analyzing, Forecasting

Reporting and 
analytical applications,
MIS & business users

Oracle Reports Developer,
Oracle Reports Services, 

Oracle Discoverer, &
Oracle Express
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Plugging into the Grid

Grid computing is:
• Software infrastructure that uses low-cost servers 

and modular storage to:
– Balance workloads
– Provide capacity on demand

• Made possible by innovations in hardware
• Powered by software
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Oracle Enterprise Grid Computing

Oracle's grid infrastructure products:
• Oracle Database 10g
• Oracle Application Server 10g
• Oracle Enterprise Manager 10g

Grid Control
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Oracle 10g Products and Forms 
Development

Forms Services Forms Developer
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Oracle Application Server 10g
Architecture
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Oracle Application Server 10g
Components

Oracle Application Server
Forms Services
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Oracle Forms Services Overview

A component of Oracle
Application Server that 
deploys Forms applications 
to Java clients in a Web 
environment

Oracle Application Server
Forms Services
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Forms Services Architecture

JRE

Application
logic layer

Data manager/
PL/SQL engine

User interface 
layer

Forms Listener 
Servlet

Forms Servlet

Forms Runtime

Client Tier Database Tier
Middle Tier:

Application Server

Incrementally
downloaded

File containing
application code

Net 
Services

Java applet

DB 
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Benefits and Components of Oracle 
Developer Suite 10g

•OWB
•Discoverer
•Reports

•JDeveloper
•Forms
•Designer
•SCM

Business Intelligence

Application Development
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Oracle Developer Suite 10g
Application Development
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Oracle Developer Suite 10g
Business Intelligence
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Oracle Forms Developer Overview

Oracle Forms Developer:
• Is a productive development environment

for Internet business applications
• Provides for:

– Data entry
– Queries
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Oracle Forms Developer: Key Features

• Tools for rapid application development
• Application partitioning
• Flexible source control
• Extended scalability
• Object reuse
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Summit Office Supply Schema

Order Entry
Application
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Summit Application

CV_Customer Canvas

CUSTOMERS Block

CV_Order Canvas

ORDERS Block

ORDER_ITEMS Block
CV_Inventory Canvas

INVENTORIES
Table

CUSTOMERS
Table

ORDERS
Table

ORDER_ITEMS
Table

Customers
Form

Orders Form

INVENTORIES Block
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Summary

In this lesson, you should have learned that:
• Grid computing makes computing power available 

without regard to its source
• Oracle 10g products provide the software to 

implement enterprise grid computing
• Oracle Application Server 10g provides services 

for building and deploying Web applications
• Oracle Developer Suite 10g includes components 

for application development and business 
intelligence
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Summary

• Benefits of Oracle Forms Services include:
– Optimized Web deployment of Forms applications
– Rich Java UI without Java coding
– Generic Java applet to deploy any Forms 

application
• Oracle Forms Services consists of the Forms 

client, the Forms Servlet, the Forms Listener 
Servlet, and the Forms Runtime Engine.

• Benefits of Oracle Forms Developer include rapid 
application development, application partitioning, 
flexible source control, extended scalability, and 
object reuse.

• The course application is a customer and order 
entry application for Summit Office Supply.
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Running a Forms
Developer Application
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Objectives

After completing this lesson, you should be able to do 
the following:
• Start OC4J
• Describe the run-time environment
• Describe the elements in a running form
• Navigate a Forms application
• Describe the two main modes of operation
• Run a form in a Web browser

– Retrieve both restricted and unrestricted data
– Insert, update, and delete records
– Display database errors
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Testing a Form: OC4J Overview

Oracle Application Server Containers for J2EE (OC4J) 
is:
• Preferred to run Forms applications
• Included with Oracle Developer Suite to enable 

testing



Copyright © 2004, Oracle.  All rights reserved.

Testing a Form: Starting OC4J

• On NT, run batch file to start
OC4J: startinst.bat.

• OC4J starts in DOS window:
– Minimize window
– Closing window aborts OC4J

• Run batch file to stop OC4J: stopinst.bat.
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Running a Form

Oracle Forms Services deployment:

Browser URL

Java Applet
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Running a Form: Browser

http://summit.com:8889/forms90/f90servlet
?form=customers.fmx&userid=username/password@database
&buffer_records=NO&debug_messages=NO&array=YES
&query_only=NO

http://summit.com:8889/forms90/f90servlet?form=customers.fmx&userid=

How do I 
access this 
application?
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The Java Runtime Environment

• The Forms applet runs in a Java Runtime 
Environment (JRE) on the client machine.

• Types of JREs:
– Java-enabled browser (native)
– JInitiator (Oracle-supplied plug-in to Web browser) 

that provides:
Incremental Java archive (JAR) file downloading
JAR file caching
Applet instance caching
Automatic Java security configuration
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Starting a Run-Time Session

URL http://summit.com:8889/forms90/f90

Static HTML files
OC4J 
or HTTP Server

Forms Servlet

Forms Listener Servlet

Forms Runtime Engine

Web Browser1
2

3

DB PLX filesMMX files 

Forms Application Executables

FMX files

Web Server 

Forms Services

Client Tier Middle Tier: Application Server
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Static HTML files
OC4J 
or HTTP Server

Forms Servlet

Forms Listener Servlet

Forms Runtime Engine

URL http://summit.com:8889/forms90/f90

Web Browser

Starting a Run-Time Session

4

5Applet started 6

DB PLX filesMMX files 

Forms Application Executables

FMX files

Web Server 

Forms Services

Middle Tier: Application ServerClient Tier
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Web Server 
Static HTML files
OC4J 
or HTTP Server

Forms Servlet

Forms Listener Servlet

Forms Runtime Engine

Forms Services

8

URL http://summit.com:8889/forms90/f90

Web Browser

Starting a Run-Time Session

Middle Tier: Application Server

8

7

DB PLX filesMMX files 

Forms Application Executables

FMX files

Client Tier
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Forms Client 
Base HTML files
Forms Servlet
Forms Listener Servlet
Forms Runtime Engine

Application Server

Static HTML files
HTTP Server or OC4J

The Forms Servlet

Dynamic 
HTML file is 

created

Desktop Client

URL PARAMETERS:
?form=customers.fmx
&userid=un/pw@db
&buffer_records=NO
...

URL Pointing to Forms Servlet

basejini.html

formsweb.cfg

http://summit.com:8889/forms90/f90servlet?form=customers.f

Web Server 

Forms Services
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The Forms Client

• Generic Java applet
• Responsibilities:

– Displays the form’s user interface
– Processes user interaction back to

Forms Services
– Processes incoming messages 

from Forms Services Generic
Java applet 

Forms Client

Desktop Client
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The Forms Listener Servlet

Java Servlet that:
• Creates Forms

Runtime process 
for each client

• Stops the Runtime process at session end
• Manages network communications between client 

and Forms Runtime process
• Communicates through Web server process

HTTP Server
or

OC4J

Middle Tier

HTTP/
HTTPS

Forms 
Listener
Servlet

Forms 
Runtime
Process
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The Runtime Engine

The Forms Runtime Engine:
• Is a process (ifweb90) that runs on the 

Application Server
• Manages application logic and processing
• Communicates with the client browser and the 

database
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What You See at Run Time

1
3

4

5 2
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Identifying the Data Elements

51 2 7 864 93 10



Copyright © 2004, Oracle.  All rights reserved.

Modes of Operation: Enter-Query Mode

Allows:
• Unrestricted and 

restricted queries
• Query/Where dialog 

box
• Record count by using 

Query > Count Hits

Does not allow:
• Navigation out of 

current data block
• Exiting run-time 

session
• Certain functions
• Insert, update, delete
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Modes of Operation: Normal Mode

Allows:
• Unrestricted queries
• Insert, update, delete
• Commit (Save)
• Navigation out of 

current data block
• Exiting run-time 

session

Does Not Allow:
• Restricted queries
• Query/Where dialog 

box
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Retrieving Data

1

3
4

2

A   B      C       D
1
2

Restricted query

A B C D

A   B     C        D
1
2
3
4

Unrestricted query

A B C D
1
2
3
4
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Retrieving Restricted Data

• Do not use quotation marks with character and 
date items.

• The LIKE operator is implied with % or _.
• Use hash (#) in front of SQL operators.
• Use Query/Where for complex query conditions.
• Use default date format (DD-MON-RR) in 

Query/Where.
• Use quotes around literals in Query/Where.
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Query/Where Dialog Box

• Invoke by:
– Entering :variable_name
– Executing query

• Used to write:
– Complex search conditions
– Queries with OR predicates
– ORDER BY clause



Copyright © 2004, Oracle.  All rights reserved.

Query/Where Dialog Box

:i

:n

:i = 104 OR :n BETWEEN ‘F’ and ‘H’
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Inserting, Updating, and Deleting

Form module

Deletes

Updates

Inserts

Memory
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Making Changes Permanent 

• Select Action > Save to 
make changes 
permanent.

• Select Action > Clear 
All to discard changes.

or
Toolbar

Menu

To commit or
rollback:

Deletes

Updates

Inserts

Memory
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Displaying Errors

• Use to view Oracle errors
• Select Help > Display Error
• Shows Database Error window:

– SQL statement
– Error information



Copyright © 2004, Oracle.  All rights reserved.

Summary

In this lesson, you should have learned that:
• You can use OC4J on the development machine to 

run a Forms application in a Web browser
• At run time:

– The Forms Client is downloaded
– The Forms Servlet creates a start HTML file
– The Forms Listener Servlet starts a run-time 

session and maintains communication between it 
and the Forms Client

– The Runtime Engine carries out application logic 
and maintains a database connection on behalf of 
the Forms Client
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Summary

• When you run a form you see a Java applet 
running in a browser and displaying a menu, menu 
toolbar, console, and several kinds of data 
elements.

• Users navigate a Forms application using the 
menu, toolbar, the mouse, buttons, or function 
keys.

• The two main modes of operation are Normal 
mode and Enter-Query mode.

• Executing a query returns all records, unless the 
query is restricted by search criteria.
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Summary

• In normal mode you can insert, update, and delete 
records and commit changes to the database.

• You display database errors from the menu 
(Help > Display Error)
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Practice 2 Overview

This practice covers the following topics:
• Starting OC4J
• Running the course application:

– Querying records
– Inserting a record
– Updating a record
– Deleting a record
– Displaying a database error
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Working in the Forms
Developer Environment
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe Forms Builder components
• Navigate the Forms Builder interface
• Identify the main objects in a form module
• Customize the Forms Builder session
• Use the online help facilities
• Identify the main Forms executables
• Describe the Forms module types
• Set environment variables for design and run time
• Run a form from within Forms Builder



Copyright © 2004, Oracle.  All rights reserved.

Forms Builder Key Features

With Forms Builder you can:
• Provide an interface for users to insert, update, 

delete, and query data
• Present data as text, image, and custom controls
• Control forms across several windows and 

database transactions
• Use integrated menus
• Send data to Oracle Reports
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Forms Builder Components:
Object Navigator

• Client-side and 
server-side 
objects 
displayed 
hierarchically

• Toolbar 
to create, 
delete or 
unload, expand 
or contract

• Icons to 
represent 
objects

• Fast 
search 
feature
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Toolbar

Tool
palette

Forms Builder Components:
Layout Editor
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Getting Started in the Forms
Builder Interface

• Start Forms Builder
• Connect to the database:

– Menu:
Select File > Connect

Or
– Toolbar:

Click Connect
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Forms Builder: Menu Structure
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Blocks, Items, and Canvases

Canvas 1 Canvas 2

Items Items

Block A Block B
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Navigation in a Block

Canvas 1 Canvas 2
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Data Blocks

A B C

A B C

Master Data Block

D

X Y Z

Detail Data Block
X Y Z

Table

Table

4

3

6

2

1
5
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Forms and Data Blocks

Block 1

Block 4

Block 1

Block 2

Block 1

Block 1

Single Form
Module

Multiple Form Modules

Form A Form B

Open
Form

Open Form
Form C

Block 2

Block 3
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Form Module Hierarchy

Module

DatabaseTable

Column

Canvas

Window

TriggerTrigger

Program 
Units
Program 

units

Trigger
Trigger

Blocks

Frame
Item
Item
Item
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Customizing Your Forms Builder Session
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Saving Preferences

Existing
Preferences File

Updated, merged
Preferences File

Motif: 
prefs.ora
Windows: 
cauprefs.ora

Modified
preferences
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Using the Online Help System
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Forms Developer Executables

Forms Compiler Forms
Services

Definitions

Run files

Forms Builder
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Forms Developer Module Types

PL/SQL
Library

Object
Library

Menus Forms

Oracle Forms Developer
components

Data sources Database

Libraries
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Defining Forms Environment Variables 
for Run Time

Set on middle-tier machine (used at run time):
• FORMS90_PATH

• ORACLE_PATH

• CLASSPATH

For Forms deployment, 
the settings in the  
environment control file 
override system settings.
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Defining Forms Environment Variables
for Design Time

Set on Developer Suite machine (used by Forms 
Builder):
• FORMS90_BUILDER_CLASSPATH

• UI_ICON

• UI_ICON_EXTENSION

• FORMS90_HIDE_OBR_PARAMS 

Windows: Modify in 
Registry 

(REGEDIT.EXE or 
REGEDT32.EXE)
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Environment Variables and
Y2K Compliance

• NLS_DATE_FORMAT

• FORMS90_USER_DATE_FORMAT

• FORMS90_USER_DATETIME_FORMAT

• FORMS90_OUTPUT_DATETIME_FORMAT

• FORMS90_OUTPUT_DATETIME_FORMAT

• FORMS90_ERROR_DATE_FORMAT

• FORMS90_ERROR_DATETIME_FORMAT
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Forms Files to Define Run-Time
Environment Variables

Environment control file:
• \forms90\server\default.env or
• Other file specified in Forms configuration file

Forms configuration file:
• \forms90\server\formsweb.cfg or other
• Used to specify:

– System parameters, such as envFile and 
workingDirectory

– User parameters, such as form and user ID
– Settings for the Java client
– Other settings
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Testing a Form: The Run Form Button

• With the Run Form menu command
or button, you can:
– Run a form from Forms Builder
– Test the form in a three-tier environment

• The Run Form command takes its settings 
from Preferences:
– Edit > Preferences
– Runtime tab
– Set Web Browser

Location if desired
– Set Application Server

URL to point to Forms
Servlet:
http://127.0.0.1:8889/forms90/f90servlet
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Summary

In this lesson, you should have learned that:
• Forms Builder includes the Object Navigator, the 

Property Palette, the Layout Editor, and the 
PL/SQL Editor

• You can use the Object Navigator or the menu and 
its associated toolbar icons to navigate around 
the Forms Builder interface

• The main objects in a form module are blocks, 
items, and canvases

• The Edit > Preferences dialog box enables you to 
customize the Forms Builder session
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Summary

• The Help menu enables you to use the online help 
facilities to look up topics, or you can invoke 
context-sensitive help

• The Forms Developer executables are the Forms 
Builder and the Forms Compiler

• The Forms Developer module types are forms, 
menus, and libraries

• You can set environment variables in the Forms 
environment file (for run time) or on the 
development machine (for design time).

• You can use the Run Form button to run a form 
from within Forms Builder
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Practice 3 Overview

This practice covers the following topics:
• Becoming familiar with the Object Navigator 
• Setting Forms Builder preferences
• Using the Layout Editor to modify the appearance 

of a form
• Setting run-time preferences to use OC4J to test 

applications
• Running a form application from within Forms 

Builder
• Setting environment variables so the Layout 

Editor in Forms Builder displays .gif images on 
iconic buttons
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Creating a Basic Form Module
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Objectives

After completing this lesson, you should be able to do
the following:
• Create a form module
• Create a data block
• Save and compile a form module
• Identify Forms file formats and their characteristics
• Describe how to deploy a form module
• Explain how to create documentation for a Forms 

application
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Create data blocks and items

Apply standards

Fine-tune layout

Set object properties

Add code

Creating a New Form Module

Test form module

Create an empty module
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Creating a New Form Module

Choose one of the following methods:
• Use wizards:

– Data Block Wizard
– Layout Wizard

• Build module manually
• Use template form
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Form Module Properties

Name
property

Coordinate
System property
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Creating a New Data Block

• Use Forms Builder Wizards:
– Data Block Wizard: Create a data block with 

associated data source quickly and easily
– Layout Wizard: Lay out data block contents for 

visual presentation
• Create manually
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Creating a New Data Block

Enter data
source

Launch Layout
Wizard

Lay out data
block contents

New Data Block

Reentrant mode

Reentrant mode

Launch Data
Block Wizard
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Navigating the Wizards

Exit 
without saving

Invoke 
online help

Save
without exiting

Save
and exit

Previous
screen

Next
screen

Available only
in reentrant mode

Tabbed Interface:
Available only in reentrant mode
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Launching the Data
Block Wizard

In Forms Builder, do one of the 
following:
• Select Tools > Data Block 

Wizard.
• Right-click and select Data 

Block Wizard.
• Select the Data Blocks node 

and click Create icon; select
Use the Data Block Wizard 
option.

• Use the Data Block Wizard 
button on the toolbar in the 
Layout Editor.
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Data Block Wizard: Type Page
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Data Block Wizard: Table Page



Copyright © 2004, Oracle.  All rights reserved.

Data Block Wizard: Finish PageData Block Wizard: Finish Page
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Layout Wizard: Items Page
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Layout Wizard: Style Page
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Layout Wizard: Rows Page
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Data Block Functionality

Once you create a data block with the wizards, Forms 
Builder automatically creates:
• A form module with database functionality 

including query, insert, update, delete
• A frame object
• Items in the data block
• A prompt for each item
• Triggers needed to enforce database constraints if 

“Enforce data integrity” is checked
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Template Forms



Copyright © 2004, Oracle.  All rights reserved.

Saving a Form Module

To save the form module:
• Select File > Save

OR
Click the Save icon

• Enter a filename
• Navigate to

desired location
• Click Save
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Compiling a Form Module

1

3

2

4
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Module Types and Storage Formats

Form 
Module

Menu
Module

PL/SQL
Library

Object
Library

.fmb .fmx .fmt

.mmb .mmx .mmt

.pll .plx .pld

.olb .olt
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Deploying a Form Module

1. Move module files to 
middle tier

2. Generate module on 
middle tier

3. Run in browser using
Forms Services on 
middle tier

1 2

3

.fmx

.fmb
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Text Files and Documentation

• Convert a binary file to a text file.
• Create an ASCII file for a form module.
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Summary

In this lesson, you should have learned that:
• To create a form module, you create an empty 

module, then add data blocks and other elements
• You can create a data block manually or with the 

Data Block Wizard and Layout Wizard
• You can save and compile a form module using 

the File and Program menus or from the toolbar
• You can store form, menu, and library modules in 

text format (useful for documentation), in a 
portable binary format, or a non-portable binary 
executable format

• To deploy a form module, you move it to the 
application server machine and generate it
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Practice 4 Overview

This practice covers the following topics:
• Creating a new form module
• Creating a data block by using Forms Builder 

wizards
• Saving and running the form module
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Creating a Master-Detail Form
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Objectives

After completing this lesson, you should be able to do 
the following:
• Create data blocks with relationships
• Modify a data block
• Modify the layout of a data block
• Run a master-detail form
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Form Block Relationships

Master

Detail

Master

Detail ↑
Master ↓

Master

Detail Detail

Detail
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CustomersOrders

Items

Form Block Relationships

Orders

Items

Orders Account Rep

Customers
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Data Block Wizard: 
Master-Detail Page
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Relation Object

• New relation object 
created in Object 
Navigator under 
master data block 
node

• Default name 
assigned:      
MasterDataBlock_
DetailDataBlock

• Triggers and program 
units generated 
automatically
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Creating a Relation Manually
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Join Condition

• The join condition creates primary-foreign key link 
between blocks

• Define a join condition using:
– Block and item names (not table and column 

names)
– Do not precede names with colon
– SQL equijoin syntax
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Deletion Properties

Isolated: Only master
is deleted

Cascading: Master and
all details are deleted

Non-isolated: If no detail
record, master is deleted

Non-isolated: Master is
not deleted if there are
any detail records

= Deleted

Master-Detail
Records
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Modifying a Relation
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Coordination Properties

Default Deferred
with auto query

Deferred
without

auto query
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Running a Master-Detail Form Module

• Automatic block linking 
for:
– Querying
– Inserting

• Default deletion rules: 
Cannot delete master 
record if detail records 
exist
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Modifying the Structure of a Data Block

• Reentrant Data Block Wizard:
1. Select frame or object in Layout 

Editor, or data block or frame in 
Object  Navigator 

2. Select Tools > Data Block 
Wizard OR
Right-click and select Data
Block Wizard   OR
Click Data Block Wizard

• Object Navigator: 
– Create or delete items
– Change item properties

• Block Property Palette: Change 
property values
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Modifying the Layout of a Data Block

• Reentrant Layout Wizard:
– Select frame in Object 

Navigator or Layout Editor
– Select Tools > Layout Wizard
– OR
– Right-click and select Layout

Wizard   OR
– Click Layout Wizard

• Layout Editor:
– Select Tools > Layout Editor
– Make changes manually

• Frame Property Palette: Change
property values
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Summary

In this lesson, you should have learned that:
• You can create data blocks with relationships by 

using the Data Block Wizard or by manually 
creating a Relation object

• When you run a master-detail form, block 
coordination is automatic depending on 
properties of the Relation object

• You can modify a data block manually or with the 
Data Block Wizard in reentrant mode

• You can modify the layout manually or with the 
Layout Wizard in reentrant mode
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Practice 5 Overview

This practice covers the following topics:
• Creating a master-detail form module
• Modifying data block layout by using the Layout 

Wizard in reentrant mode
• Saving and running the form module
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Working with Data Blocks and Frames
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Objectives

After completing this lesson, you should be able to do 
the following:
• Identify the components of the Property Palette
• Manage object properties
• Create and use Visual Attributes
• Control the behavior and appearance of data 

blocks
• Control frame properties
• Create blocks that do not directly correspond to 

database tables
• Delete data blocks and their components
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Managing Object Properties

• Reentrant Wizard
– Data Block Wizard
– Layout Wizard

• Layout Editor
• Property Palette

1 2

3
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Displaying the Property Palette

To display the Property Palette, use 
one of the following methods:
• Select Tools > Property Palette (or 

use the shortcut key).
• Double-click the object icon in the 

Object Navigator.
• Double-click the object in the 

Layout Editor.
• Right-click the object icon in 

the Object Navigator.
• Right-click the object in the 

Layout Editor.
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Property Palette: Features

Property
name

Property 
value

Toolbar

Expand/
collapse

Find field

Search
backward

Search
forward

Help: 
Press [F1]
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Property Controls

Text field

LOV window

Pop-up list

More button
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Property Controls

Changed

Default

Overridden

Inherited
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Visual Attributes

A Visual Attribute 
is a named set of 
properties defining:
• Font
• Color
• Pattern
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How to Use Visual Attributes

1. Create a Visual Attribute.
2. Set the Visual Attribute–related property of an 

object to the desired Visual Attribute.
3. Run the form to see the effect.

21

3
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Font, Pattern, and Color Pickers
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Controlling Data Block Behavior
and Appearance

Data Block Property Groups:
• General
• Navigation
• Records
• Database
• Advanced Database
• Scrollbar
• Visual Attributes
• Color
• International
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Navigation Properties

ORDERS
Order

Item
Same
Record
Next
Record

Previous Navigation Data Block

Next Navigation Data Block
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Records Properties

Item

Number 

of Records

Displayed

Current Record
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Records Properties

Vertical Record Orientation

Horizontal Record Orientation
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Database Properties

Use properties in the Database 
group to control:
• Type of block—data or 

control block
• Query, insert, update, and 

delete operations on the 
data block

• Data block’s data source
• Query search criteria and 

default sort order
• Maximum query time
• Maximum number of 

records fetched
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SELECT ....

WHERE Clause

[ORDER BY Clause]

Database Properties

Work file

Block display

Records
fetched

Records buffered
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Scroll Bar Properties

Record

Scroll Bar X/Y
Position

Scroll Bar Width

Scroll
Bar
Height
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Controlling Frame Properties
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Controlling Frame Properties

Item

Form
Layout
Style

Tabular
Layout
Style

Distance
between
records

Order
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Displaying Multiple Property Palettes

Two Palettes for Two Items: Two Palettes for One Item: 
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Setting Properties on Multiple Objects

Intersection/
Union
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Copying Properties

Copy Paste

Source objects Destination objects

Properties

Name ITEMS
Query All Records Yes
Query Allowed Yes
Insert Allowed Yes
Update Allowed No
Delete Allowed Yes

Query All Records No
Query Allowed Yes
Insert Allowed Yes
Update Allowed Yes
Delete Allowed Yes
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Creating a Control Block

• Click the Data Blocks node
• Click the Create icon

OR
Select Edit > Create.

• Select the “Build a new data 
block manually” option in the 
New Data Block dialog box.
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Deleting a Data Block

• Select a data block for deletion
• Click the Delete icon

OR
Press [Delete]

• Click Yes in the alert box.
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Summary

In this lesson, you should have learned that:
• The Property Palette:

– Contains property names and values that enable you to 
modify Forms objects

– Has tools to search for properties, inherit properties, 
expand or collapse property categories, and pop up lists 
and dialog boxes for various properties

– Shows different icons for default, changed, inherited, and 
overridden properties

• Block properties control the behavior and appearance 
of data blocks

• Frame properties control how block items are arranged
• You can create blocks that do not directly correspond 

to database tables by choosing to create the block 
manually rather than using the Data Block Wizard

• Deleting a data block deletes all of its components
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Practice 6 Overview

This practice covers the following topics:
• Creating a control block
• Creating a Visual Attribute
• Invoking context-sensitive help from the Property 

Palette
• Modifying data block properties
• Modifying frame properties
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Working with Text Items
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe text items
• Create a text item
• Modify the appearance of a text item
• Control the data in a text item
• Alter the navigational behavior of a text item
• Enhance the relationship between the text item 

and the database
• Add functionality to a text item
• Display helpful messages
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Text Item Overview

What is a text item?
• Default item type
• Interface object for:

– Querying
– Inserting
– Updating
– Deleting

• Behavior defined in 
the Property Palette
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Creating a Text Item
Canvas selection Block selection
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Modifying the Appearance of a Text Item: 
General and Physical Properties
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Modifying the Appearance of a Text Item: 
Records Properties

Distance
between
records

Number
of items
displayed

Orders

Items
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Modifying the Appearance of a Text Item: 
Font and Color Properties

Use properties in the Font 
and Color groups to 
specify an item’s:
• Visual attributes
• Font name, size,

weight, style, 
color, andpattern
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Modifying the Appearance of a Text Item: 
Prompts

• A prompt specifies 
the text label that is 
associated with an 
item.

• Several properties are 
available to arrange 
and manage prompts.

• Use prompt 
properties to change 
the appearance of an 
item prompt.
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Associating Text with an Item Prompt

1

2

3

4
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Controlling the Data of a Text Item

Use properties in Data group 
to control the data:
• Type
• Length
• Format
• Value

1 2 3 4 5US7ASCII
VARCHAR2(5 CHAR)

1 2 3 4 5JA16SJIS
VARCHAR2(5 CHAR)

1 2 3UTF8
VARCHAR2(5 CHAR)
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Controlling the Data of a Text Item: 
Format

Format masks:
• Standard SQL formats

– Dates             FXDD-MON-YY
– Numbers       L099G990D99

• Nonstandard formats
Use double quotes for 
embedded characters
“(“099”)”099“-”0999

Note: Allow for format mask’s 
embedded characters when 
defining Width property.
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Initial Values:
• Are used for every new record
• Can be overwritten
• Must be compatible with item’s data type
• Use:

– Raw value
– System variable
– Global variable
– Form parameter
– Form item
– Sequence

Controlling the Data of a Text Item:
Values
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ORDERS

Sales

1Region Id

Name

Id Last Name First Name Title Dept Id
3 Nagayama Midori VP, Sales 31
11 Magee Colin Sales Rep 31

Employee

31Id

Controlling the Data of a Text Item:
Copy Value from Item

<data_block_name>.<item_name>Dept
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Controlling the Data of a Text Item:
Synchronize with Item
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Altering Navigational Behavior of 
Text Items

• Established by order of 
entries in Object Navigator

• Alter by:
– Keyboard Navigable
– Previous Navigation Item
– Next Navigation Item
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Enhancing the Relationship Between Text 
Item and Database

Use properties in the Database 
group to control:
• Item’s data source—base 

table item or control item
• Query, insert, and update 

operations on an item
• Maximum query length 
• Query case
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Adding Functionality to a Text Item

Item

Id      Product Id                Price          Quantity     Item Total
10011                             135                  500     67,500.00

10013                             380                  400   152,000.00         

1
2

Order
CREDITOrder Id 100

Enabled=No

Case
Restriction=
Upper

Justification = Start

Justification = Right

Payment
Type
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Adding Functionality to a Text Item: 
Conceal Data Property
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Adding Functionality to a Text Item: 
Keyboard Navigable and Enabled

• Set both properties to 
allow or disallow 
navigation and interaction 
with text item.

• When Enabled is set to 
Yes, Keyboard Navigable 
can be set to Yes or No.

• When Enabled is set to No, 
the item is always 
nonnavigable.
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Adding Functionality to a Text Item: 
Multi-line Text Items

Text

Text

Text

Text

Width

Height

Total text = Maximum length
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Displaying Helpful Messages:
Help Properties

Hint

Tooltip
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Summary

In this lesson, you should have learned that:
• Text items are interface objects that usually 

correspond to database columns
• You can create a text item with:

– The Text Item tool in the Layout Editor
– The Create icon in the Object Navigator
– The Data Block Wizard
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Summary

• You can modify a text item in its Property Palette:
– General, Records, and Physical properties control 

the appearance of the text item
– Data properties control the length, datatype, format, 

and other aspects of the data.
– Navigation properties control how to navigate to 

and from a text item.
– Database properties specify the relationship 

between the text item and its corresponding 
database column.

– Functional properties control how the text item 
functions.

– Help properties specify the display of helpful 
messages.
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Practice 7 Overview

This practice covers the following topics:
• Deleting text items
• Modifying text item properties
• Creating text items
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Creating LOVs and Editors
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe LOVs and editors
• Design, create, and associate LOVs with text items 

in a form module
• Create editors and associate them with text items 

in a form module
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Overview of LOVs and Editors

Text item

Editor

Text item Text item

LOV

Supporting data
record group
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Overview of LOVs and Editors

• LOVs
– List of values for text items
– Dynamic or static list
– Independent of single text items
– Flexible and efficient

• Editors
– Override default editor
– Used for special requirements such as larger 

editing window, position, color, and title
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LOVs and Record Groups

Text item

LOV

Text item

LOV

Database

Record group Record groupRecord group
based on

static data

Query-based
record
group

OR
SQL
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LOVs and Record Groups

EMPLOYEES
table

SELECT employee_id, first_name || 
' '|| last_name NAME, 
phone_number
FROM employees
WHERE job_id = 'SA_REP'
ORDER BY last_name

Employee_id Name
Sales Rep record group

Sales Representatives LOV
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Creating an LOV Manually

1

2

3

4
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Creating an LOV with the LOV Wizard:
SQL Query Page

Edit query 
if needed
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Creating an LOV with the LOV Wizard: 
Column Selection Page
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Creating an LOV with the LOV Wizard: 
Column Properties Page
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Creating an LOV with the LOV Wizard: 
Display Page
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Creating an LOV with the LOV Wizard: 
Advanced Properties Page
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Creating an LOV with the LOV Wizard: 
Assign to Item Page
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LOV Properties

Filter Before
Display

?

(X,Y)

Automatic
Select

Automatic
Skip

Width

Height

LOV

Column Mapping

Return Items
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Setting LOV Properties

LOV

Column Mapping

Automatic
Position

Automatic
Column Width

Return Items
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LOVs: Column Mapping

Employee_id

orders.sales_rep_id orders.sales_rep_name orders.salesrep_phone

Hidden
column

Phone number
1-415-555-6281
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Defining an Editor
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Setting Editor Properties
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Associating an Editor with a Text Item

• Associate one of two 
types of editors with a 
text item.

• Set text item’s Editor 
property to one of the 
following:
– Null (default Forms 

Builder editor)
– Editor name 

(customized editor)
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Summary

In this lesson, you should have learned that:
• An LOV is a scrollable pop-up window that 

enables a user to pick the value of an item from a 
multicolumn dynamic list

• The easiest way to design, create, and associate 
LOVs with text items is to use the LOV Wizard

• An Editor is a separate window that enables the 
user to view multiple lines of a text item 
simultaneously, search and replace text in it, and 
modify the text

• You create editors in the Object Navigator and 
associate them with text items in the item's 
Property Palette
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Practice 8 Overview

This practice covers the following topics:
• Creating an LOV and attaching the LOV to a text 

item
• Creating an Editor and attaching it to a text item



Copyright © 2004, Oracle.  All rights reserved.

Creating Additional Input Items
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Objectives

After completing this lesson, you should be able to do 
the following:
• Identify the item types that allow input
• Create a check box
• Create a list item
• Create a radio group
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Input Items Overview

What are input items?
• Item types that accept user input include:

– Check boxes
– List items
– Radio groups

• Input items enable insert, update, delete, and 
query.
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Check Boxes Overview

What Are Check Boxes?
• Two-state interface object:

– Checked
– Unchecked

• Not limited to two values
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Creating a Check Box

• Convert an existing item.
• Use the Check Box tool in the Layout Editor.
• Use the Create icon in the Object Navigator.
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Converting an Existing Item into a 
Check Box

Convert text item
to check box
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Creating a Check Box in the Layout Editor

Use check box tool
in Layout Editor
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Setting Check Box Properties

• Data Type
• Label
• Access Key
• Value When Checked
• Value When Unchecked
• Check Box Mapping of 

Other Values
• Mouse Navigate
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Check Box Mapping of Other Values

Y

Y

N

Null

A

Order_Mode Checked

Unchecked

Check Box Mapping of
Other Values
Unchecked

Y

N
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What Are List Items?
• Set of mutually exclusive choices, each 

representing a different value
• Three list styles available:

• Space-saving alternative to a radio group
• Smaller-scale alternative to an LOV

List Items Overview

Poplist Combo BoxTlist
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Creating a List Item

• Convert an existing item.
• Use the List Item tool in the Layout Editor.
• Use the Create icon in the Object Navigator.
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Converting an Existing Item into a 
List Item
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Creating a List Item in the Layout Editor

Use list item tool
in Layout Editor
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Setting List Item Properties

• Elements in List:
– List elements
– List item value

• List Style
• Mapping of Other Values
• Mouse Navigate
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List Item Mapping of Other Values

Order_Status

10

4

2
0

12

CREDIT order paid

New CASH order

List Elements

Mapping of Other 
Values = 11 (Unknown)

Unknown

CASH backorder

New CREDIT order

Values for Forms Items Displayed Values
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Radio Groups Overview

What are radio groups?
• Set of mutually exclusive radio buttons, each 

representing a value
• Use:

– To display two or more static choices
– As an alternative to a list item
– As an alternative to a check box
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Creating a Radio Group

• Convert an existing item.
• Create a new radio button in the Layout Editor.
• Use the Create icon in the Object Navigator.
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Converting Existing Item to Radio Group

Change Item Type and
set other properties

Create radio buttons for
the radio group
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Creating Radio Group in Layout Editor
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Setting Radio Properties

Radio group: Radio button:
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Radio Group Mapping
of Other Values

Credit_Limit

500

2000
Null

5000

List Elements

LOW_BUTTON
Low

MEDIUM_BUTTON
Medium

HIGH_BUTTON
High

Mapping of
Other Values

2000

Values for Forms Items Displayed Values
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Summary

In this lesson, you should have learned that:
• Check boxes, list items, and radio groups are the 

item types that allow input
• You create these items by:

– Changing the item type of an existing item
– Using the appropriate tool in the Layout Editor

• You can use a check box for items that have only 
two possible states

• You can use a list item to enable users to pick 
from a list of mutually exclusive choices

• You can use a radio group for two or three 
mutually exclusive alternatives
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Practice 9 Overview

This practice covers the following topics:
• Converting a text item into a list item
• Converting a text item into a check box item
• Converting a text item into a radio group
• Adding radio buttons to the radio group
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Creating Noninput Items
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Objectives

After completing this lesson, you should be able to do 
the following:
• Identify item types that do not allow input
• Create a display item
• Create an image item
• Create a button
• Create a calculated item
• Create a hierarchical tree item
• Create a bean area item
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Noninput Items Overview

Item types that do not accept direct user input include:
• Display items
• Image items
• Buttons
• Calculated items
• Hierarchical tree items
• Bean area items
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Display Items

Display items:
• Are similar to text items.
• Cannot:

– Be edited
– Be queried
– Be navigated 

to
– Accept user 

input
• Can display:

– Nonbase table information
– Derived values
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Creating a Display Item
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Image Items

Use image items to display images:
• From file system—supported file type
• From database—LONG RAW column or a BLOB 

column
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Image File Formats

Image item

Image files Image files

Read Write

PICT

TPIC

CALS

TIFF

GIF

JFIF

BMP

RAS

CALS

GIF

BMP

RAS

JPEG

TIFF

JFIF

JPEG

PICT

TPIC
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Creating an Image Item
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Setting Image-Specific Item Properties

• Image Format
• Image Depth
• Compression Quality
• Display Quality
• Sizing Style
• Show Horizontal 

Scroll Bar
• Show Vertical 

Scroll Bar
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Push Buttons

Push buttons:
• Cannot display or represent data
• Are used to initiate an action
• Display as:

– Text button
– Iconic
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Push Button Actions

Use buttons to:
• Move input focus
• Display an LOV
• Invoke an editor
• Invoke another window
• Commit data
• Issue a query
• Perform calculations
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Creating a Push Button
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Setting Push Button Properties

• Label
• Iconic
• Icon Filename
• Default Button
• Mouse Navigate
• Tooltip
• Tooltip Visual 

Attribute Group
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Calculated Items

What are calculated items?
• They accept item values that are based on 

calculations.
• They are read-only.
• They can be expressed as:

– Formula
– Summary
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Creating a Calculated Item by
Setting Properties

• Formula
– A calculated item value is the result of a horizontal 

calculation.
– It involves bind variables.

• Summary
– A calculated item value is a vertical calculation.
– A summary is performed on values of a single item 

over all rows in a block.
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Setting Item Properties for the 
Calculated Item

• Formula
– Calculation Mode
– Formula

• Summary
– Calculation Mode
– Summary Function
– Summarized Block
– Summarized Item
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Summary Functions

• AVG
• COUNT
• MAX
• MIN
• STDDEV
• SUM
• VARIANCE
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Calculated Item Based on a Formula

ORDERS

Item#
Prod

Id
Unit
Price Quantity

Item
Total

1
2

4
3

200
120
50
25

5
4
9
3

1,000
480
450
75

NVL((:order_items.unit_price * 

:order_items.quantity),0)

Formula
item

Orders

Items

Description
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Rules for Calculated Item Formulas

Create calculated item formulas according to the 
following rules:
• A formula item must not invoke restricted built-

ins.
• A formula item cannot execute any DML 

statements.
• Do not terminate a PL/SQL expression with a 

semicolon.
• Do not enter a complete PL/SQL statement in 

assignment expressions.
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Calculated Item Based on a Summary

ORDERS

1
2

4
3

200
120
50
25

5
4
9
3

1,000
480
450
75

2,005Order Total

Summarized
item

Summary
item

Item#
Prod

Id
Unit
Price Quantity

Item
TotalDescription

Orders

Items
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Rules for Summary Items

• Summary item must reside in:
– The same block as the summarized item
– A control block with Single Record property set to 

Yes
• Summarized item must reside in:

– A data block with Query All Records property or 
Precompute Summaries property set to Yes

– A control block
• Datatype of summary item must be Number, 

unless using MAX or MIN
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Creating a Hierarchical Tree Item
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Setting Hierarchical Tree Item Properties

• Allow empty branches
• Multi selection
• Show lines
• Show symbols
• Record group
• Data query
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Bean Area Items

The Bean Area item enables you to:
• Add a JavaBean to a form
• Extend Forms functionality
• Interact with client machine
• Reduce network traffic
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Creating a Bean Area Item

Create bean area 
in Layout Editor

Convert existing item
to bean area 
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Setting Bean Area Item Properties
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The JavaBean at Run Time
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Summary

In this lesson, you should have learned that:
• The following item types do not allow input: 

– Display items
– Image items
– Push buttons
– Calculated items
– Hierarchical tree items
– Bean area items

• You create noninput items by:
– Changing the type of an existing item and setting 

certain properties
– Using the appropriate tool in the Layout Editor
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Summary

• You can use:
– A display item to show nonbase table information
– An image item to display an image
– A push button to initiate action
– A calculated item to display the results of a formula 

or a summary function of another item
– A hierarchical tree item to display related data in a 

hierarchical fashion
– A bean area item to execute client-side Java code
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Practice 10 Overview

This practice covers the following topics:
• Creating display items
• Creating an image item
• Creating iconic buttons
• Creating calculated items:

– Formula
– Summary

• Creating a bean area item
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Creating Windows and Content Canvases
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe the relationship between windows and 

content canvases
• Create windows and content canvases
• Display a form module in multiple windows
• Display a form module on multiple layouts
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Windows and Canvases

• Window: Container for 
Forms Builder visual 
objects

• Canvas: Surface on 
which you “paint” 
visual objects

• To see a canvas and its 
objects, display the 
canvas 
in a window.
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Window, Canvas, and Viewport

MDI 
parent 
window

Document
window

Canvas
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The Content Canvas

• “Base” canvas
• View occupies entire window
• Default canvas type
• Each window should have at least one content 

canvas
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Relationship Between Windows and 
Content Canvases

Canvas 2 Canvas 3

Canvas 1

Window
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The Default Window

WINDOW1:
• Created by default with each 

new form module
• Is modeless
• You can delete, rename, or 

change its attributes
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Displaying a Form Module in
Multiple Windows

• Use additional windows to:
– Display two or more content canvases at once
– Switch between canvases

without replacing the 
initial one

– Modularize form 
contents

– Take advantage of 
the window manager

• Two types of windows:
– Modal
– Modeless
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Creating a New Window
Object Navigator: Click Create
with Windows node selected

Property Palette:
Set properties
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Setting Window Properties

3

5

4

1 2
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GUI Hints

• GUI hints are recommendations to the window 
manager about window appearance and 
functionality.

• If the window manager supports a specific GUI 
Hint and its property is set to Yes, it will be used.

• Functional properties for GUI Hints:
– Close Allowed
– Move Allowed
– Resize Allowed
– Maximize Allowed
– Minimize Allowed
– Inherit Menu
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Displaying a Form Module on
Multiple Layouts

PROPERTIES:

Canvas 
CV_ORDER

Window: 
WIN_ORDERS

Canvas 
CV_INVENTORY

Window: 
WIN_INVENTORY
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Creating a New Content Canvas

• Explicitly: 

• Implicitly:

1

2
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Setting Content Canvas Properties

Viewport 
X/Y Position
on Canvas

CanvasViewport
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Summary

In this lesson, you should have learned that:
• Windows can display multiple content canvases, 

but can display only one canvas at a time
• Content canvases are displayed only in the 

window to which they are assigned
• You must assign at least one content canvas to 

each window in your application
• You create windows in the Object Navigator; one 

is created by default with each new module
• You create canvases in the Object Navigator, by 

using the Layout Wizard, or by invoking the 
Layout Editor in a module without a canvas

• You can display a multiple layouts by assigning 
canvases to different windows.
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Practice 11 Overview

This practice covers the following topics:
• Changing a window size, position, name, and title
• Creating a new window
• Displaying data block contents in the new window
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Working with Other Canvas Types
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe the different types of canvases and their 

relationships to each other
• Identify the appropriate canvas type for different 

scenarios
• Create an overlay effect by using stacked 

canvases
• Create a toolbar
• Create a tabbed interface
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Content canvas

Overview of Canvas Types

Stacked
canvas

Horizontal toolbar

Vertical
toolbar

x y zTab

Tab
page
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The Stacked Canvas

• Displayed on top of a content canvas
• Shares a window with a content canvas
• Size:

– Usually smaller than the content canvas in the same 
window

– Determined by viewport size
• Created in:

– Layout Editor
– Object Navigator
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The Stacked Canvas

1

5

2

4

3
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Creating a Stacked Canvas
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Setting Stacked Canvas Properties
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The Toolbar Canvas

• Special type of canvas for tool items
• Two types:

– Vertical toolbar
– Horizontal toolbar

• Provide:
– Standard look and feel
– Alternative to menu or function key operation
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The MDI Toolbar

Form property:

Runtime parameter: Window property: 
otherparams=useSDI=no
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Creating a Toolbar Canvas

1. Create:
– Click Create in Object Navigator
– Change Canvas Type 
– Set other properties as required

2. Add functionality
3. Resize the canvas (not the view)
4. Assign to window and/or form
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Setting Toolbar Properties

• Canvas properties:
– Canvas Type
– Window
– Width or Height

• Window properties:
– Horizontal Toolbar 

Canvas
– Vertical Toolbar 

Canvas
• Form Module properties:

– Form Horizontal Toolbar Canvas
– Form Vertical Toolbar Canvas
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The Tab Canvas

• Enables you to organize and display related 
information on separate tabs

• Consists of one or more tab pages
• Provides easy access to data
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Creating a Tab Canvas

• Create in:
– Object Navigator
– Layout Editor

• Define tab pages
• Place items on tab pages
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Creating a Tab Canvas in the Object 
Navigator

Create new Canvas Set Canvas Type Create Tab Pages
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Setting Tab Canvas, Tab Page, 
and Item Properties

2

3

1
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Placing Items on a Tab Canvas

• Place items on each tab page for user interaction.
• Set the item properties:

– Canvas
– Tab Page
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Summary

In this lesson, you should have learned:
• Canvas types other than content canvases:

– Stacked: Overlays and shares window with content 
canvas; use to create cascading or revealing effect 
within a single window, display additional 
information, display or hide information 
conditionally, or display context-sensitive help

– Toolbar: Area that displays at the top or to the left 
of a content canvas; use to to hold buttons and 
other frequently used GUI elements with a standard 
look and feel across canvases displayed in the 
same window

– Tab: Has multiple pages where you navigate using 
tabs; use to organize and display related 
information on different tabs
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Summary

• You can create these in Object Navigator and 
change the canvas type, then set properties.

• You can create stacked or tab canvases with the 
appropriate tool in the Layout Editor.

• You can attach a Toolbar canvas to single 
window, or to entire form if using MDI.

• After creating a tab canvas, create tab pages and 
place related items on them.
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Practice 12 Overview

This practice covers the following topics:
• Creating a toolbar canvas
• Creating a stacked canvas
• Creating a tab canvas
• Adding tab pages to the tab canvas
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Introduction to Triggers
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Objectives

After completing this lesson, you should be able to do 
the following:
• Define triggers
• Identify the different trigger categories
• Plan the type and scope of triggers in a form
• Describe the properties that affect the behavior of 

a trigger
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Trigger Overview

Event

Trigger types

Queries

Validation

Navigation

Interaction

Internal event

Errors/Messages

Others

PL/SQL

Fire
PL/SQL

PL/SQL

Which trigger would you use to perform complex calculations 
after a user enters data into an item?
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Grouping Triggers into Categories

Triggers may be grouped 
into functional categories:
• Block processing 

triggers
• Interface event triggers
• Master-detail triggers
• Message handling 

triggers
• Navigational triggers
• Query-time triggers
• Transactional triggers
• Validation triggers

Triggers may be grouped 
into categories based on 
name:
• When-Event triggers
• On-Event triggers
• Pre-Event triggers
• Post-Event triggers
• Key triggers
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Defining Trigger Components

What event? What action?

What level?

Type
Code

Scope
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Trigger Type

• Pre-
• Post-
• When-
• On-
• Key-
• User-named

Type

Code

Scope

What event?
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Trigger Type

Forms Builder Trigger Types



Copyright © 2004, Oracle.  All rights reserved.

Trigger Code

• Statements
• PL/SQL
• User 

subprograms
• Built-in 

subprograms

Type

Code

Scope

What action?
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Trigger Scope

Levels
• Form
• Block
• Item

Code

Scope

Type

What level?
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Trigger Scope

EventEvent

Event

Order 
Date
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Specifying Execution Hierarchy

Form
level

Block
level

Item
level

On-Message

On-Message

On-Message

On-Error

On-Error

EH = After

EH = After

EH = Before

EH = Override

1

2

3

4

Event

Event
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Summary

In this lesson, you should have learned that:
• Triggers are event-activated program units
• You can categorize triggers based on function or 

name to help you understand how they work
• Trigger components are:

– Type: Defines the event that fires the trigger
– Code: The actions a trigger performs
– Scope: Specifies the level (form, block, or item) at 

which the trigger is defined
• The Execution Hierarchy trigger property alters 

the firing sequence of a trigger
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Producing Triggers
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Objectives

After completing this lesson, you should be able to do 
the following:
• Write trigger code
• Explain the use of built-in subprograms in Forms 

applications
• Describe the When-Button-Pressed trigger
• Describe the When-Window-Closed trigger
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Creating Triggers in Forms Builder

To produce a trigger:
1. Select a scope in the Object Navigator.
2. Create a trigger and select a name from the 

Trigger LOV, or use the SmartTriggers menu 
option.

3. Define code in the PL/SQL Editor.
4. Compile.
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Creating a Trigger

Step One:

Select Trigger Scope.

Form level

Block level

Item level
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Creating a Trigger

Step Two:

Invoke the 
Trigger LOV.
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Creating a Trigger

Step Three:

Use the PL/SQL Editor to define the trigger code.
Name

ItemObjectType

Source
Pane

Toolbar

Step Four:

Compile.
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Setting Trigger Properties
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PL/SQL Editor Features

Split view

Split Bars

5

1 432
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PL/SQL Editor Features

The
Syntax
Palette
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The Database Trigger Editor
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Writing Trigger Code

BEGIN

END;

A PL/SQL Block
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• PL/SQL variables must be declared in a trigger or 
defined in a package

• Forms Builder variables
– Are not formally declared in PL/SQL
– Need a colon (:) prefix in reference

Using Variables in Triggers
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Forms Builder Variables

Variable 
Type

Items

Global 
variable

System 
variables

Parameters

Purpose

Presentation and 
user interaction

Session-wide 
character variable

Form status and 
control

Passing values in 
and out of module

Syntax

:block_name.item_name

:GLOBAL.variable_name

:SYSTEM.variable_name

:PARAMETER.name
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Adding Functionality with
Built-In Subprograms

Built-ins belong to either:
• The Standard Extensions 

package where no prefix is 
required

• Another Forms Builder 
package where a prefix is 
required
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Limits of Use

• Unrestricted built-ins are allowed in any trigger or 
subprogram.

• Restricted built-ins are allowed only in certain 
triggers and subprograms called from such 
triggers.

• Consult the Help 
system.

Compiles:

Run-time error when 
trigger fires:
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1

Using Built-In Definitions

4

2

3
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Useful Built-Ins

• EDIT_TEXTITEM

• ENTER_QUERY, EXECUTE_QUERY
• EXIT_FORM

• GET_ITEM_PROPERTY, SET_ITEM_PROPERTY
• GO_BLOCK, GO_ITEM
• MESSAGE

• SHOW_ALERT, SHOW_EDITOR, SHOW_LOV
• SHOW_VIEW, HIDE_VIEW
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Using Triggers:
When-Button-Pressed Trigger

• Fires when the operator clicks a button
• Accepts restricted and unrestricted built-ins
• Use to provide convenient navigation, to display 

LOVs and many other frequently used functions

GO_BLOCK(‘Stock’);
EXECUTE_QUERY;
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Using Triggers:
When-Window-Closed Trigger

• Fires when the operator closes a window by using 
a window manager-specific close command.

• Accepts restricted and unrestricted built-ins.
• Used to programmatically close a window when 

the operator issues a window manager-specific 
close command. You can close a window by using 
built-ins.

Why can't I close 
this window?
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Summary

In this lesson, you should have learned that:
• You can use the PL/SQL Editor to write trigger 

code
• Trigger code has three sections:

– Declaration section (optional)
– Executable statements section (required)
– Exception handlers section (optional)

• You can add functionality by calling built-in 
subprograms from triggers

• Restricted built-ins are not allowed in triggers that 
fire while navigation is occurring
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Summary

• The When-Button-Pressed trigger fires when the 
user presses a button

• The When-Window-Closed trigger fires when the 
user closes a window
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Practice 14 Overview

This practice covers the following topics:
• Using built-ins to display LOVs
• Using the When-Button-Pressed and 

When-Window-Closed triggers to add 
functionality to applications

• Using built-ins to display and hide the Help stack 
canvas
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Debugging Triggers
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe the components of the Debug Console
• Use the Run Form Debug button to run a form 

module in debug mode 
• Debug PL/SQL code 
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The Debugging Process

Monitor and debug triggers by:
• Compiling and 

correcting errors in 
the PL/SQL Editor

• Displaying debug 
messages at run 
time

• Invoking the 
PL/SQL Debugger
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The Debug Console

• Stack
• Variables
• Watch
• Form Values
• PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints

Dock/
Undock

Click 
bar for 
Pop-up
Menu
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The Debug Console: Stack Panel

• Stack
• Variables
• Watch
• Form Values
• PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints
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The Debug Console: Variables Panel

• Stack
• Variables
• Watch
• Form Values
• PL/SQL 

Packages
• Global and 

System Variables 
• Breakpoints

Read-only:
Modifiable:
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The Debug Console: Watch Panel

• Stack
• Variables
• Watch
• Form Values
• PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints
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The Debug Console: Form Values Panel

• Stack
• Variables
• Watch
• Form Values
• PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints
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The Debug Console: 
PL/SQL Packages Panel

• Stack
• Variables
• Watch
• Form Values
• PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints
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The Debug Console: 
Global/System Variables Panel

• Stack
• Variables
• Watch
• Form Values
• Loaded PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints
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The Debug Console: Breakpoints Panel

• Stack
• Variables
• Watch
• Form Values
• Loaded PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints
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The Debug Console

• Stack
• Variables
• Watch
• Form Values
• Loaded PL/SQL 

Packages
• Global and 

System Variables
• Breakpoints
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Setting Breakpoints in Client Code

Breakpoints:
• Suspend form 

execution
• Return control 

to the debugger
• Remain in effect 

for the Forms 
Builder session

• May be enabled 
and disabled

• Are set in the 
PL/SQL Editor 
on executable 
lines of code

Before setting breakpoint:

After setting breakpoint:
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Setting Breakpoints in Stored Code

• Can set on stored program units:
– Expand Database Objects node
– Expand <schema> node
– Expand PL/SQL Stored Program Units node
– Double-click program unit
– Set breakpoint in PL/SQL Editor

• Cannot set on database triggers or stored PL/SQL 
libraries

• Compile with debug information
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Debugging Tips

• Connect to the database for SQL compilation.
• The line that fails is not always responsible.
• Watch for missing semicolons and quotation 

marks.
• Define triggers at the correct level.
• Place triggers where the event will happen.
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Running a Form in Debug Mode

Run Form
Debug

Contains source 
code and

executable run file
.FMX

(Compiles automatically)

(Runs automatically)

Runs Form in
Debug Mode on
Server specified

in Runtime 
Preferences
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Stepping Through Code

Step over

Step
out

Stop

GO

Step
into

Pause
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Debug Example

…calls...

The results are: ??WHEN-BUTTON-
PRESSED

1

Procedure XYZ;

Function ABC;

2

3

4

5

Debug Example
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Summary

In this lesson, you should have learned that:
• The Debug Console consists of panes to view the 

call stack, program variables, a user-defined 
watch list, Form values, loaded PL/SQL packages, 
global and system variables, and breakpoints

• You use the Run Debug button to run a form 
module in debug mode within Forms Builder

• You can set breakpoints in the PL/SQL Editor by 
double-clicking to the left of an executable line of 
code

• The debug buttons in the Forms Builder toolbar 
enable you to step through code in various ways
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Practice 15 Overview

This practice covers the following topics:
• Running a form in debug mode from Forms 

Builder
• Setting breakpoints
• Stepping through code
• Viewing variable values while form is running
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Adding Functionality to Items
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Objectives

After completing this lesson, you should be able to do 
the following:
• Supplement the functionality of input items by 

using triggers and built-ins
• Supplement the functionality of noninput items by 

using triggers and built-ins
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Item Interaction Triggers

When-List-Changed

When-List-Activated

When-Tree-Node-Activated

When-Tree-Node-Expanded

When-Tree-Node-Selected

When-Button-Pressed

When-Checkbox-Changed

When-Custom-Item-Event

When-Radio-Changed

When-Image-Pressed

When-Image-Activated



Copyright © 2004, Oracle.  All rights reserved.

Coding Item Interaction Triggers

• Valid commands:
– SELECT statements
– Standard PL/SQL constructs
– All built-in subprograms

• Do not fire during:
– Navigation
– Validation (use When-Validate-“object” to code 

actions to take place during validation)
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Interacting with Check Boxes

When-Checkbox-Changed
IF CHECKBOX_CHECKED('CONTROL.case_sensitive') THEN
SET_ITEM_PROPERTY('CUSTOMERS.cust_first_name',
CASE_INSENSITIVE_QUERY, PROPERTY_FALSE);

SET_ITEM_PROPERTY('CUSTOMERS.cust_last_name',
CASE_INSENSITIVE_QUERY, PROPERTY_FALSE);

ELSE
SET_ITEM_PROPERTY('CUSTOMERS.cust_first_name',
CASE_INSENSITIVE_QUERY, PROPERTY_TRUE);

SET_ITEM_PROPERTY('CUSTOMERS.cust_last_name',
CASE_INSENSITIVE_QUERY, PROPERTY_TRUE);

END IF;
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Changing List Items at Run Time

Triggers:
• When-List-Changed
• When-List-Activated

Built-ins:
• ADD_LIST_ELEMENT

• DELETE_LIST_ELEMENT

Excellent

Excellent

Good

Poor

Index

1

2

3
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Displaying LOVs from Buttons

• Uses:
– Convenient alternative for accessing LOVs
– Can display independently of text items

• Needs:
– When-Button-Pressed trigger
– LIST_VALUES or SHOW_LOV built-in
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LOVs and Buttons

IF SHOW_LOV(’myLov’)

THEN...

When-Button-Pressed

Name   
Roel
Glenn 
Gary
Michael
Jeff
Lynn
Kate
Patrice
Pam

ID 
101
102 
103
104
105
106
107
108
109

105

Employees (LOV)

105
Employee_IdLOV button
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v

^

Populating Image Items

Database

Fetch on query

Image file
(in the application server file system)

WRITE_IMAGE_FILE

READ_IMAGE_FILE
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Loading the Right Image

READ_IMAGE_FILE

(TO_CHAR(:ORDER_ITEMS.product_id)||’.JPG’,

’JPEG’,’ORDER_ITEMS.product_image’ );

READ_IMAGE_FILE

Image file
in the application server file system
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Populating Hierarchical Trees

SET_TREE_PROPERTY

Database

When-Button-Pressed

CREATE_GROUP_FROM_QUERY

Record Group

Car
Ford
Volvo
VW
Toyota

-
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Displaying Hierarchical Trees

When-Button-Pressed
rg_emps := create_group_from_query('rg_emps',

'select 1, level, last_name, NULL,

to_char(employee_id) ' ||

'from employees ' ||

'connect by prior employee_id = manager_id '||

'start with job_id = ''AD_PRES''');

v_ignore := populate_group(rg_emps);

ftree.set_tree_property('block4.tree5',

ftree.record_group, rg_emps);
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Interacting with JavaBeans

• Tell Forms about the bean: Register
• Communication from Forms to JavaBean:

– Invoke Methods
– Get/Set Properties

• Communication from JavaBean to Forms: Events

Methods
Properties
Events
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Interacting with JavaBeans

The FBEAN package provides built-ins to:

• Register the bean
• Invoke methods of the 

bean
• Get and set properties on 

the bean
• Subscribe to bean events
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Interacting with JavaBeans

• Register a listener for the event:
FBEAN.ENABLE_EVENT('MyBeanArea',1,'mouseListener'
, true);

• When an event occurs on the bean:
– The When-Custom-Item-Event trigger fires.
– The name and information are sent to Forms in:

:SYSTEM.CUSTOM_ITEM_EVENT

:SYSTEM.CUSTOM_ITEM_EVENT_PARAMETERS

2

4
31



Copyright © 2004, Oracle.  All rights reserved.

Interacting with JavaBeans

The JavaBean may:
• Not have a visible component
• Not communicate via events
• Return a value to the form when invoked (use like 

a function)

2

4

3

1

51,255,255
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Summary

In this lesson, you should have learned that:
• You can use triggers to supplement the 

functionality of:
– Input items:

When-[Checkbox | Radio]-Changed
When-List-[Changed | Activated]

– Noninput items:
When-Button-Pressed
When-Image-[Pressed | Activated]
When-Tree-Node-[Activated | Expanded | Selected]
When-Custom-Item-Event
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Summary

• You can call useful built-ins from triggers:
– CHECKBOX_CHECKED

– [ADD | DELETE]_LIST_ELEMENT

– SHOW_LOV

– [READ | WRITE]_IMAGE_FILE

– FTREE: POPULATE_TREE, ADD_TREE_DATA,
[GET | SET]_TREE_PROPERTY

– FBEAN: [GET | SET]_PROPERTY, INVOKE,     
REGISTER_BEAN, ENABLE_EVENT
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Practice 16 Overview

This practice covers the following topics:
• Writing a trigger to check whether the customer’s 

credit limit has been exceeded
• Creating a toolbar button to display and hide 

product images
• Coding a button to enable users to choose a 

canvas color for a form
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Run Time Messages and Alerts
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe the default messaging behavior of a form
• Handle run-time failure of built-in subprograms
• Identify the different types of Forms messages
• Control system messages
• Create and control alerts
• Handle database server errors
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Run-Time Messages and Alerts Overview

System 
Application 

Alerts

Messages
Informative

Error
Working

Application
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Detecting Run-Time Errors

• FORM_SUCCESS

– TRUE: Action successful
– FALSE: Error/Fatal error occurred

• FORM_FAILURE

– TRUE: A nonfatal error occurred
– FALSE: Action successful or a fatal error occurred

• FORM_FATAL

– TRUE: A fatal error occurred
– FALSE: Action successful or a nonfatal error 

occurred
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Errors and Built-Ins

• Built-In failure does not cause an exception.
• Test built-in success with FORM_SUCCESS function.

IF FORM_SUCCESS THEN . . .
OR IF NOT FORM_SUCCESS THEN . . .

• What went wrong?
– ERROR_CODE, ERROR_TEXT, ERROR_TYPE
– MESSAGE_CODE, MESSAGE_TEXT, MESSAGE_TYPE
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Message Severity Levels

>25

20

15

10

5

0

25

All (default)

More critical

Define by:

:SYSTEM.MESSAGE_LEVEL
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Suppressing Messages

:SYSTEM.MESSAGE_LEVEL := ’5’;

UP;

IF NOT FORM_SUCCESS THEN

MESSAGE(’Already at the first Order’);

END IF;

:SYSTEM.MESSAGE_LEVEL := ’0’;

:SYSTEM.SUPPRESS_WORKING := ’TRUE’;
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The FORM_TRIGGER_FAILURE Exception
BEGIN

-
-
RAISE form_trigger_failure;
-
-

EXCEPTION

-
-
WHEN <exception> THEN
RAISE form_trigger_failure;
-
-

Fail trigger

END;



Copyright © 2004, Oracle.  All rights reserved.

Triggers for Intercepting
System Messages

• On-Error:
– Fires when a system error message is issued
– Is used to trap Forms and Oracle Server errors, and 

to customize error messages
• On-Message:

– Fires when an informative system message is 
issued

– Is used to suppress or customize specific 
messages
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Handling Informative Messages

• On-Message trigger
• Built-in functions:

– MESSAGE_CODE

– MESSAGE_TEXT

– MESSAGE_TYPE
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Setting Alert Properties

1

2

6543 7

Alert Styles:

Caution

Stop

Note
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Planning Alerts
Yes/No

questions
Yes/No/Cancel

questions

Caution
messages

Informative
messages
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Controlling Alerts

SET_ALERT_PROPERTY

SET_ALERT_BUTTON_PROPERTY
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SHOW_ALERT Function

IF SHOW_ALERT(’del_Check’)=ALERT_BUTTON1 THEN

. . .

Alert_Button1
Alert_Button2

Alert_Button3
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Directing Errors to an Alert

PROCEDURE Alert_On_Failure IS

n NUMBER;

BEGIN

SET_ALERT_PROPERTY(’error_alert’,

ALERT_MESSAGE_TEXT,ERROR_TYPE||

’-’||TO_CHAR(ERROR_CODE)||

’: ’||ERROR_TEXT);

n := SHOW_ALERT(’error_alert’);

END;
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Causes of Oracle Server Errors

Base table block

Implicit DML

Trigger/PU

Explicit DML

Stored PU call

Declarative
constraint

Database
trigger

Stored
program unit

Form Oracle Server
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Trapping Server Errors

Base table block

On-Error:
DBMS_ERROR_CODE
DBMS_ERROR_TEXT

Explicit DML/PU call

When Others:
SQLCODE
SQLERRM

Constraint

DB trigger

Stored PU

Form Oracle Server

Predefined
message

RAISE_
APPLICATION_

ERROR

RAISE_
APPLICATION_

ERROR
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Summary

In this lesson, you should have learned that:
• Forms displays messages at run time to inform 

the operator of events that occur in the session.
• You can use FORM_SUCCESS to test for run-time 

failure of built-ins.
• There are four types of Forms messages:

– Informative
– Error
– Working
– Application
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Summary

• You can control system messages with built-ins 
and triggers:
– MESSAGE_LEVEL

– SUPPRESS_WORKING

– On-[Error | Message] triggers
– [ERROR | MESSAGE]_[CODE | TEXT | TYPE]

• Types of alerts: Stop, Caution, Note
• Alert built-ins:

– SHOW_ALERT

– SET_ALERT_PROPERTY

– SET_ALERT_BUTTON_PROPERTY
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Summary

• Handle database server errors:
– Implicit DML: Use DBMS_ERROR_CODE and 

DBMS_ERROR_TEXT in On-Error trigger
– Explicit DML: Use SQLCODE and SQLERRM in WHEN

OTHERS exception handler
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Practice 17 Overview

This practice covers the following topics:
• Using an alert to inform the operator that the 

customer’s credit limit has been exceeded
• Using a generic alert to ask the operator to 

confirm that the form should terminate
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Query Triggers
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Objectives

After completing this lesson, you should be able to do 
the following:
• Explain the processes involved in querying a data 

block
• Describe query triggers and their scope
• Write triggers to screen query conditions
• Write triggers to supplement query results
• Control trigger action based on the form’s query 

status
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Construct SELECT...

Perform query

Fetch a row into a new record

Mark record as valid

Validate any record changes

Abort query
on failure

Query Processing Overview

Flush
record

on failure

Fire Pre-Query trigger

Fire Post-Query trigger
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SELECT Statements Issued During
Query Processing

SELECT base_column, ..., ROWID

INTO :base_item, ..., :ROWID

FROM base_table

WHERE (default_where_clause OR

onetime_where_clause)

AND (example_record_conditions)

AND (query_where_conditions)

ORDER BY default_order_by_clause |

query_where_order_by

Slightly different for COUNT
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WHERE Clause

• Four sources for the WHERE clause:
– WHERE Clause block property
– ONETIME_WHERE block property
– Example Record
– Query/Where dialog box

• WHERE clauses are combined by the AND operator, 
except that WHERE and ONETIME_WHERE are 
combined with the OR operator.
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ONETIME_WHERE Property

Initially shows
restricted query

2nd Execute_Query
not restricted
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ORDER BY Clause

• Two sources for the ORDER BY clause:
– ORDER BY Clause block property
– Query/Where dialog box

• Second source for ORDER BY clause overrides the 
first one
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Writing Query Triggers: Pre-Query Trigger

• Defined at block level
• Fires once, before query is performed

IF TO_CHAR(:ORDERS.ORDER_ID)||

TO_CHAR(:ORDERS.CUSTOMER_ID)

IS NULL THEN 

MESSAGE(’You must query by 

Order ID or Customer ID’);

RAISE form_trigger_failure;

END IF;
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Writing Query Triggers:
Post-Query Trigger

• Fires for each fetched record (except during array 
processing)

• Use to populate nondatabase items and calculate 
statistics

SELECT COUNT(order_id) 

INTO :ORDERS.lineitem_count

FROM ORDER_ITEMS

WHERE order_id = :ORDERS.order_id;



Copyright © 2004, Oracle.  All rights reserved.

Writing Query Triggers:
Using SELECT Statements in Triggers

• Forms Builder variables are preceded by a colon.
• The query must return one row for success.
• Code exception handlers.
• The INTO clause is mandatory, with a variable for 

each selected column or expression.
• ORDER BY is not relevant.



Copyright © 2004, Oracle.  All rights reserved.

Query Array Processing

• Reduces network traffic
• Enables Query Array processing:

– Enable Array Processing option
– Set Query Array Size property

• Query Array Size property
• Query All Records property
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Coding Triggers for
Enter-Query Mode

• Some triggers may fire in Enter-Query mode.
• Set the Fire in Enter-Query Mode property.
• Test mode during execution with :SYSTEM.MODE

– NORMAL

– ENTER-QUERY

– QUERY
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Coding Triggers for
Enter-Query Mode

• Example

• Some built-ins are illegal.
• Consult online Help.
• You cannot navigate to another record in the 

current form.

IF :SYSTEM.MODE = ’NORMAL’ 

THEN ENTER_QUERY;

ELSE EXECUTE_QUERY;

END IF;
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Overriding Default Query Processing

Do-the-Right-Thing Built-in

COUNT_QUERY

FETCH_RECORDS

SELECT_RECORDS

Trigger

On-Close

On-Count

On-Fetch

Pre-Select

On-Select

Post-Select

Additional Transactional Triggers for Query Processing
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Overriding Default Query Processing

• On-Fetch continues to fire until:
– It fires without executing 

CREATE_QUERIED_RECORD.
– The query is closed by the user or by ABORT_QUERY.
– It raises FORM_TRIGGER_FAILURE.

• On-Select replaces open cursor, parse, and 
execute phases.
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Obtaining Query Information at Run Time

• SYSTEM.MODE

• SYSTEM.LAST_QUERY

– Contains bind variables (ORD_ID = :1) before 
SELECT_RECORDS

– Contains actual values (ORD_ID = 102) after 
SELECT_RECORDS
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Obtaining Query Information at Run Time

• GET_BLOCK_PROPERTY
SET_BLOCK_PROPERTY

– Get and set:
DEFAULT_WHERE
ONETIME_WHERE
ORDER_BY
QUERY_ALLOWED
QUERY_HITS

– Get only:
QUERY_OPTIONS
RECORDS_TO_FETCH
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Obtaining Query Information at Run Time

• GET_ITEM_PROPERTY

• SET_ITEM_PROPERTY

– Get and set:
CASE_INSENSITIVE_QUERY
QUERYABLE
QUERY_ONLY

– Get only:
QUERY_LENGTH
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Summary

In this lesson, you should have learned that:
• Query processing includes the following steps:

1. Pre-Query trigger fires
2. SELECT statement constructed
3. Query performed
4. Record fetched into block
5. Record marked Valid
6. Post-Query trigger fires
7. Item and record validation if the record has 

changed (due to a trigger)
8. Steps 4 through 7 repeat till all fetched
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Summary

• The query triggers, which must be defined at block 
or form level, are:
– Pre-Query: Use to screen query conditions (set 

ONETIME_WHERE or DEFAULT_WHERE properties, or 
assign values to use as query criteria)

– Post-Query: Use to supplement query results 
(populate nonbase table items, perform 
calculations)

• You can use transactional triggers to override 
default query processing.

• You can control trigger action based on the form’s 
query status by checking SYSTEM.MODE values: 
NORMAL, ENTER-QUERY, or QUERY
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Practice 18 Overview

This practice covers the following topics:
• Populating customer names and sales 

representative names for each row of the ORDERS
block

• Populating descriptions for each row of the 
ORDER_ITEMS block

• Restricting the query on the INVENTORIES block 
for only the first query on that block

• Disabling the effects of the Exit button and 
changing a radio group in Enter-Query mode

• Adding two check boxes to enable case-sensitive 
and exact match query
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Validation
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Objectives

After completing this lesson, you should be able to do 
the following:
• Explain the effects of the validation unit upon a 

form
• Control validation:

– Using object properties
– Using triggers
– Using Pluggable Java Components

• Describe how Forms tracks validation status
• Control when validation occurs
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The Validation Process

Forms validates at the following levels:

Form level

Block level

Record level Item level
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The Validation Process

Validation occurs when:
• [Enter] key or ENTER Built-in is 

obeyed
• Operator or trigger leaves the validation unit 

(includes a Commit)



Copyright © 2004, Oracle.  All rights reserved.

Controlling Validation Using Properties: 
Validation Unit
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Controlling Validation Using Properties: 
Validate from List

LOV

TERRY
Full list

MART
Partial list

Valid

Auto complete
AL

ALAN

HDATE
---------------

20-FEB-1981
22-FEB-1981
06-MAR-1996
06-FEB-1995

08-SEP-1981

ENAME
---------------

MARTIN
MARTINEZ
SEDAT
WARD 

ALAN

WARD
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Controlling Validation Using Triggers

• Item level:
When-Validate-Item

• Block level:
When-Validate-Record

IF :ORDERS.order_date > SYSDATE THEN 

MESSAGE(Order Date is later than today!’);

RAISE form_trigger_failure;

END IF;
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Example: Validating User Input

Trigger failure?

When-Validate-Item

Customer ID

SELECT . . .

WHERE customer_id = 

:ORDERS.customer_id

104
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Using Client-Side Validation

• Forms 
validation:
– Occurs on 

middle tier
– Involves 

network 
traffic

• Client-side 
validation:
– Improves 

performance
– Implemented 

with PJC

Attempt to enter alphabetic characters

Using number datatype

Using KeyFilter PJC
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Using Client-Side Validation

To use a PJC:
1. Set the item’s Implementation Class property

2. Set properties for the PJC
SET_CUSTOM_PROPERTY('order_items.quantity',

1,'FILTER_TYPE','NUMERIC');
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Tracking Validation Status

• NEW
– When a record is created
– Also for Copy Value from Item or Initial Value

• CHANGED
– When changed by user or trigger
– When any item in new record is changed

• VALID
– When validation has been successful
– After records are fetched from database
– After a successful post or commit
– Duplicated record inherits status of source
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Controlling When Validation Occurs with 
Built-Ins

• CLEAR_BLOCK, CLEAR_FORM, EXIT_FORM
• ENTER

• SET_FORM_PROPERTY

– (..., VALIDATION)
– (..., VALIDATION_UNIT)

• ITEM_IS_VALID item property
• VALIDATE (scope)



Copyright © 2004, Oracle.  All rights reserved.

Summary

In this lesson, you should have learned that:
• The validation unit specifies how much data is 

entered before validation occurs.
• You can control validation using:

– Object properties: Validation Unit (form); Validate 
from List (item)

– Triggers: When-Validate-Item (item level); When-
Validate-Record (block level)

– Pluggable Java Components for client-side 
validation
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Summary

• Forms tracks validation status of items and 
records, which are either NEW, CHANGED, or VALID.

• You can use built-ins to control when validation 
occurs:
– CLEAR_BLOCK

– CLEAR_FORM

– EXIT_FORM

– ENTER

– ITEM_IS_VALID

– VALIDATE
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Practice 19 Overview

This practice covers the following topics:
• Validating the Sales Representative item value by 

using an LOV
• Writing a validation trigger to check that online 

orders are CREDIT orders
• Populating customer names, sales representative 

names, and IDs when a customer ID is changed
• Writing a validation trigger to populate the name 

and the price of the product when the product ID 
is changed

• Restricting user input to numeric characters using 
a Pluggable Java Component 
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Navigation
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Objectives

After completing this lesson, you should be able to do 
the following:
• Distinguish between internal and external 

navigation
• Control navigation with properties
• Describe and use navigation triggers to control 

navigation
• Use navigation built-ins in triggers
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Navigation Overview

• What is the navigational unit?
– Outside the form
– Form
– Block
– Record
– Item

• Entering and leaving objects
• What happens if navigation fails?
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v

^
x

Understanding Internal Navigation

Next Record

Exit item

Exit record

Enter record

Enter item
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Using Object Properties to Control 
Navigation

• Block
– Navigation Style
– Previous Navigation Data Block
– Next Navigation Data Block

• Item
– Enabled
– Keyboard Navigable
– Mouse Navigate 
– Previous Navigation Item
– Next Navigation Item
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Using Object Properties to Control 
Navigation

• Form module
– Mouse 

Navigation Limit
– First Navigation 

Data Block



Copyright © 2004, Oracle.  All rights reserved.

v

^

Mouse Navigate Property

x

MOUSE NAVIGATE = YES

Exit item

Exit record

Exit block

Enter block

Enter record

Enter item
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v

^
x

Writing Navigation Triggers

Pre- and Post-

When-New-<object>-Instance
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Navigation Triggers

When-New-<object>-Instance

Fire after navigation

Fire even when validation unit is 
higher than the trigger object

Allow restricted and 
unrestricted built-ins

Are not affected by failure

Pre- and Post-

Fire during navigation

Do not fire if validation unit 
is higher than trigger object

Allow unrestricted built-ins

Handle failure by returning to 
initial object



Copyright © 2004, Oracle.  All rights reserved.

When-New-<object>-Instance Triggers

• When-New-Form-Instance
• When-New-Block-Instance
• When-New-Record-Instance
• When-New-Item-Instance
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SET_<object>_PROPERTY Examples

SET_FORM_PROPERTY(FIRST_NAVIGATION_BLOCK, 

’ORDER_ITEMS’);

SET_BLOCK_PROPERTY(’ORDERS’, ORDER_BY, 

’CUSTOMER_ID’);

SET_RECORD_PROPERTY(3, ’ORDER_ITEMS’, STATUS, 

QUERY_STATUS);

SET_ITEM_PROPERTY(’CONTROL.stock_button’, 

ICON_NAME, ’stock’);
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The Pre- and Post-Triggers

• Pre/Post-Form
• Pre/Post-Block
• Pre/Post-Record
• Pre/Post-Text-Item



Copyright © 2004, Oracle.  All rights reserved.

Post-Block Trigger Example

Disabling Stock button when leaving the ORDER_ITEMS
block:

SET_ITEM_PROPERTY(’CONTROL.stock_button’, 

enabled, property_false);



Copyright © 2004, Oracle.  All rights reserved.

v

^

The Navigation Trap

A Post-Text-Item

Pre-Text-Item

Pre-Text-Item

B
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Using Navigation Built-Ins in Triggers

GO_FORM

GO_BLOCK

GO_ITEM

GO_RECORD

NEXT_BLOCK

NEXT_ITEM

NEXT_KEY

NEXT_RECORD

NEXT_SET

UP

DOWN

PREVIOUS_BLOCK

PREVIOUS_ITEM

PREVIOUS_RECORD

SCROLL_UP

SCROLL_DOWN
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IF CHECKBOX_CHECKED(’ORDERS.order_mode’) --Online

THEN -- order

ORDERS.order_status := 4; --Credit order

GO_ITEM(‘ORDERS.order_status’);

END IF;

IF CHECKBOX_CHECKED(’ORDERS.order_mode’) --Online

THEN -- order

ORDERS.order_status := 4; --Credit order

GO_ITEM(‘ORDERS.order_status’);

END IF;

Using Navigation Built-Ins in Triggers

• When-New-Item-Instance

• Pre-Text-Item
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Summary

In this lesson, you should have learned that:
• External navigation is visible to the user, while 

internal navigation occurs behind the scenes.
• You can control navigation with properties of the 

form, block, or item:
– Set in Navigation category of the Property Palette
OR
– Use SET_[FORM | BLOCK | ITEM]_PROPERTY
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Summary

• Navigation triggers:
– Those that fire during navigation (watch out for the 

navigation trap):
[Pre | Post] - [Form | Block | Item]

– Those that fire after navigation: 
When-New- [Form | Block | Record | Item] -Instance

• You can use navigation built-ins in triggers 
(except for triggers that fire during navigation):
– GO_[FORM | BLOCK | RECORD | ITEM]
– NEXT_[BLOCK | RECORD | ITEM | KEY | SET]
– UP
– DOWN
– PREVIOUS_[BLOCK | RECORD | ITEM]
– SCROLL_[UP | DOWN]
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Practice 20 Overview

This practice covers the following topics:
• Registering the bean area’s JavaBean at form 

startup
• Setting properties on a Pluggable Java 

Component at form startup
• Executing a query at form startup
• Populating product images when cursor arrives on 

each record of the ORDER_ITEMS block
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Transaction Processing
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Objectives

After completing this lesson, you should be able to do 
the following:
• Explain the process used by Forms to apply 

changes to the database
• Describe the commit sequence of events
• Supplement transaction processing
• Allocate sequence numbers to records as they are 

applied to tables
• Implement array DML
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Transaction Processing Overview

Transaction (Begin)

FORM A
Action Edit 

Block#1

Block#2

New Record
Updated Record

Deleted Record
Updated Record

Commit work;

INSERT INTO Table1

UPDATE Table1

DELETE FROM Table2

UPDATE Table2

Transaction (End)

Save
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Transaction Processing Overview

Transaction processing includes two phases:
• Post:

– Writes record changes to base tables
– Fires transactional triggers

• Commit: Performs database commit
Errors result in:
• Rollback of the database changes
• Error message
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The Commit Sequence of Events

Validate the block

Pre-Commit

Pre-Delete

Delete row

Post-Delete

More 
records?

1

On-Delete

Validate the form

2
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The Commit Sequence of Events

Check uniqueness

On-Insert Insert row

Post-Insert Post-Update

More
blocks?

Post-Forms-Commit

INSERT UPDATE

Stop

2

More 
records?

Pre-Insert

Copy value from item

Pre-Update

Check uniqueness

On-Update Update row

1

Post-Database-Commit
Commit changes
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Characteristics of Commit Triggers

• Pre-Commit: Fires once if form changes are made 
or uncommitted changes are posted

• Pre- and Post-DML
• On-DML: Fires per record, replacing default DML 

on row
Use DELETE_RECORD, INSERT_RECORD, 
UPDATE_RECORD built-ins
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Characteristics of Commit Triggers

• Post-Forms-Commit: Fires once even if no 
changes are made

• Post-Database-Commit: Fires once even if no 
changes are made

Note: A commit-trigger failure causes a rollback to the 
savepoint.
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Common Uses for Commit Triggers

Pre-Commit

Pre-Delete

Pre-Insert

Pre-Update

Check user authorization; set up special locking

Journaling; implement foreign-key delete rule

Generate sequence numbers; journaling; 
automatically generated columns; check 
constraints

Journaling; implement foreign-key update rule; 
auto-generated columns; check constraints 
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Common Uses for Commit Triggers

On-Insert/Update/Delete

Post-Forms-Commit

Post-Database-Commit

Replace default block
DML statements

Check complex multirow 
constraints

Test commit success;
test uncommitted posts
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ColumnItem

Life of an Update

Query
Rollback

Data20 20

Locked
Query

30 20Update record in form

[Save] 30 20[Save]

Pre-Update 30 20

Row Updated 30 30 20Row updated

Post-Update 30 30 20

30 30

Post-Update

Pre-Update

Commit
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Delete Validation

• Pre-Delete trigger
• Final checks before row deletion
DECLARE

CURSOR C1 IS
SELECT ’anything’ FROM ORDERS 
WHERE customer_id = :CUSTOMERS.customer_id;   

BEGIN
OPEN C1;
FETCH C1 INTO :GLOBAL.dummy;
IF C1%FOUND THEN 

CLOSE C1;
MESSAGE(’There are orders for this 

customer!’);
RAISE form_trigger_failure;

ELSE
CLOSE C1;

END IF;
END;
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Assigning Sequence Numbers

Pre-Insert Insert

Database

601 Value Value

ID

Sequence

SELECT ORDERS_SEQ.nextval

INTO :ORDERS.order_id

FROM SYS.dual;

601

602
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Keeping an Audit Trail

• Write changes to nonbase tables.
• Gather statistics on applied changes.

Post-Insert example:

:GLOBAL.insert_tot :=

TO_CHAR(TO_NUMBER(:GLOBAL.insert_tot)+1);
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Testing the Results of Trigger DML

• SQL%FOUND

• SQL%NOTFOUND

• SQL%ROWCOUNT

UPDATE ORDERS

SET order_date = SYSDATE

WHERE order_id = :ORDERS.order_id;

IF SQL%NOTFOUND THEN 

MESSAGE(’Record not found in database’);

RAISE form_trigger_failure;

END IF;
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Testing the Results of Trigger DML

• SQL%FOUND

• SQL%NOTFOUND

• SQL%ROWCOUNT

UPDATE S_ORD

SET date_shipped = SYSDATE

WHERE id = :S_ORD.id;

IF SQL%NOTFOUND THEN 

MESSAGE(’Record not found in database’);

RAISE form_trigger_failure;

END IF;
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DML Statements Issued 
During Commit Processing

INSERT INTO base_table (base_column, base_column,...)

VALUES (:base_item, :base_item, ...)

UPDATE base_table

SET base_column = :base_item, base_column = 

:base_item, ...

WHERE ROWID = :ROWID

DELETE FROM base_table

WHERE ROWID = :ROWID
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DML Statements Issued During 
Commit Processing

Rules:
• DML statements may fire database triggers.
• Forms uses and retrieves ROWID.
• The Update Changed Columns Only and Enforce 

Column Security properties affect UPDATE
statements.

• Locking statements are not issued.
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Overriding Default Transaction Processing

Additional transactional triggers:

On-Check-Unique

On-Column-Security

On-Commit

On-Rollback

On-Savepoint

On-Sequence-Number

CHECK_RECORD_UNIQUENESS

ENFORCE_COLUMN_SECURITY

COMMIT_FORM

ISSUE_ROLLBACK

ISSUE_SAVEPOINT

GENERATE_SEQUENCE_NUMBER

Trigger Do-the-Right-Thing Built-in

Note: These triggers are meant to be used when connecting to 
data sources other than Oracle.
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Overriding Default Transaction Processing

Transactional triggers for logging on and off:

Pre-Logon

Pre-Logout

On-Logon

On-Logout

Post-Logon

Post-Logout

-

-

LOGON

LOGOUT

-

-

Trigger Do-the-Right-Thing Built-in
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Running Against Data Sources
Other than Oracle

• Two ways to run against data sources other than 
Oracle:
– Oracle Transparent Gateways
– Write appropriate transactional triggers
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Running Against Data Sources
Other than Oracle

• Connecting with Open Gateway:
– Cursor and Savepoint mode form module properties
– Key mode and Locking mode block properties

• Using transactional triggers:
– Call 3GL programs
– Database data block property
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Getting and Setting the 
Commit Status

• Commit status: Determines how record will be 
processed

• SYSTEM.RECORD_STATUS:
– NEW
– INSERT (also caused by control items)
– QUERY
– CHANGED

• SYSTEM.BLOCK_STATUS:
– NEW (may contain records with status INSERT)
– QUERY (also possible for control block)
– CHANGED (block will be committed)

• SYSTEM.FORM_STATUS: NEW, QUERY, CHANGED
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Getting and Setting the
Commit Status

• System variables versus built-ins for commit 
status

• Built-ins for getting and setting commit status:
– GET_BLOCK_PROPERTY

– GET_RECORD_PROPERTY

– SET_RECORD_PROPERTY
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Getting and Setting the
Commit Status

• Example: If the third record of block ORDERS is a 
changed database record, set the status back to 
QUERY.

• Warnings:
– Do not confuse commit status with validation 

status.
– The commit status is updated during validation.
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Array DML

• Performs array inserts, updates, and deletes
• Vastly reduces network traffic

Fewer round trips 
(exact number depends

on array size)
2 inserts

2 updates

1 delete
Database

Empno Ename Job Hiredate

1234 Jones Clerk 01-Jan-1995
1235 Smith Clerk 01-Jan-1995

1236 Adams Clerk 01-Jan-1995
1237 Clark Clerk 01-Jan-1995
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Effect of Array DML
on Transactional Triggers

Array DML Size = 1 Array DML Size > 1

Fires
Fires for each 
insert, update,
delete

Fires for each 
insert, update, 
delete

Repeated
for each
insert,
update,
delete

POST-

PRE-

DML

Fires

DML

POST-

PRE-
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Implementing Array DML

1. Enable the Array Processing option.
2. Specify a DML Array Size of greater than 1.
3. Specify block primary keys.
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Summary

In this lesson, you should have learned that:
• To apply changes to the database, Forms issues 

post and commit.
• The commit sequence of events:

1. Validate the form.
2. Process savepoint.
3. Fire Pre-Commit.
4. Validate the block (performed for all blocks in 

sequential order).
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Summary

5.  Perform the DML:
Delete records: Fire Pre-Delete, delete row or fire 
On-Delete, fire Post-Delete trigger
Insert records: Copy Value From Item, fire 
Pre-Insert, check record uniqueness, insert row or 
fire On-Insert, fire Post-Insert
Update records: Fire Pre-Update, check record 
uniqueness, update row or fire On-Update, fire 
Post-Update

6. Fire Post-Forms-Commit trigger.
If the current operation is COMMIT, then:

7. Issue an SQL-COMMIT statement.
8. Fire the Post-Database-Commit trigger.
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Summary

• You can supplement transaction processing with 
triggers:
– Pre-Commit: Fires once if form changes are made 

or uncommitted changes are posted
– [Pre | Post] – [Update | Insert | Delete]
– On- [Update | Insert | Delete]:

Fires per record, replacing default DML on row
Perform default functions with built-ins:
[UPDATE|INSERT|DELETE]_RECORD
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Summary

• Use the Pre-Insert trigger to allocate sequence 
numbers to records as they are applied to tables.

• Check or change commit status:
– GET_BLOCK_PROPERTY, [GET | 

SET]_RECORD_STATUS

– :SYSTEM.[FORM | BLOCK | RECORD]_STATUS

• Use transactional triggers to override or augment 
default commit processing.

• Reduce network roundtrips by setting DML Array 
Size block property to implement Array DML.
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Practice 21 Overview

This practice covers the following topics:
• Automatically populating order IDs by using a 

sequence
• Automatically populating item IDs by adding the 

current highest order ID
• Customizing the commit messages in the 

CUSTOMERS form
• Customizing the login screen in the CUSTOMERS

form
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Writing Flexible Code
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe flexible code
• State the advantages of using system variables
• Identify built-in subprograms that assist flexible 

coding
• Write code to reference objects:

– By internal ID
– Indirectly
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What Is Flexible Code?

Flexible code:
• Is reusable
• Is generic
• Avoids hard-coded object names
• Makes maintenance easier
• Increases productivity
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Using System Variables for 
Current Context

• Input focus:
– SYSTEM.CURSOR_BLOCK

– SYSTEM.CURSOR_RECORD

– SYSTEM.CURSOR_ITEM

– SYSTEM.CURSOR_VALUE

IF :SYSTEM.CURSOR_BLOCK = ’ORDERS’ THEN

GO_BLOCK(’ORDER_ITEMS’);

ELSIF :SYSTEM.CURSOR_BLOCK = ’ORDER_ITEMS’ THEN

GO_BLOCK(’INVENTORIES’);

ELSIF :SYSTEM.CURSOR_BLOCK = ’INVENTORIES’ THEN

GO_BLOCK(’ORDERS’);

END IF;
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Using System Variables for 
Current Context

• Trigger focus:
– SYSTEM.TRIGGER_BLOCK

– SYSTEM.TRIGGER_RECORD

– SYSTEM.TRIGGER_ITEM



Copyright © 2004, Oracle.  All rights reserved.

System Status Variables

When-Button-Pressed

ENTER;

IF :SYSTEM.BLOCK_STATUS = ’CHANGED’ THEN  

COMMIT_FORM;

END IF;

CLEAR_BLOCK;
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GET_<object>_PROPERTY 
Built-Ins

• GET_APPLICATION_PROPERTY

• GET_FORM_PROPERTY

• GET_BLOCK_PROPERTY

• GET_RELATION_PROPERTY

• GET_RECORD_PROPERTY

• GET_ITEM_PROPERTY

• GET_ITEM_INSTANCE_PROPERTY
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GET_<object>_PROPERTY 
Built-Ins

• GET_LOV_PROPERTY

• GET_RADIO_BUTTON_PROPERTY

• GET_MENU_ITEM_PROPERTY

• GET_CANVAS_PROPERTY

• GET_TAB_PAGE_PROPERTY

• GET_VIEW_PROPERTY

• GET_WINDOW_PROPERTY
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SET_<object>_PROPERTY
Built-Ins

• SET_APPLICATION_PROPERTY

• SET_FORM_PROPERTY

• SET_BLOCK_PROPERTY

• SET_RELATION_PROPERTY

• SET_RECORD_PROPERTY

• SET_ITEM_PROPERTY

• SET_ITEM_INSTANCE_PROPERTY
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SET_<object>_PROPERTY 
Built-Ins

• SET_LOV_PROPERTY

• SET_RADIO_BUTTON_PROPERTY

• SET_MENU_ITEM_PROPERTY

• SET_CANVAS_PROPERTY

• SET_TAB_PAGE_PROPERTY

• SET_VIEW_PROPERTY

• SET_WINDOW_PROPERTY
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Referencing Objects by Internal ID

lov_id := FIND_LOV(’my_lov’)

...SHOW_LOV(lov_id)

...SHOW_LOV(’my_lov’)

Finding the object ID:

Referencing an object by ID:

Referencing an object by name:

ID

ID
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FIND_ Built-Ins

• FIND_ALERT

• FIND_BLOCK

• FIND_CANVAS

• FIND_EDITOR

• FIND_FORM

• FIND_ITEM

• FIND_LOV

• FIND_RELATION

• FIND_VIEW

• FIND_WINDOW

ID
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Using Object IDs

• Declare a PL/SQL variable of the same data type.
• Use the variable for any later reference to the 

object.
• Use the variable within the current PL/SQL block 

only.
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Using Object IDs

Example:

DECLARE

item_var item;

BEGIN

item_var := FIND_ITEM(:SYSTEM.CURSOR_ITEM);

SET_ITEM_PROPERTY(item_var,position,30,55);

SET_ITEM_PROPERTY(item_var,prompt_text,’Cur

rent’);

END;
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Increasing the Scope of Object IDs

• A PL/SQL variable has limited scope.
• An .id extension:

– Broadens the scope
– Converts to a numeric format
– Enables assignment to a global variable
– Converts back to the object data type
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Referencing Objects Indirectly

Direct reference

Indirect reference

ITEM A
Welles

ITEM B
ITEM A

ITEM A
Welles
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Referencing Objects Indirectly

The NAME_IN function:
• Returns:

– The contents of variable
– Character string

• Use conversion functions for NUMBER and DATE
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Referencing Objects Indirectly

The COPY procedure allows:
• Direct copy:

• Indirect copy:

COPY('Welles','CUSTOMERS.cust_last_name');

COPY('Welles',NAME_IN('global.customer_name_item'));
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Summary

In this lesson, you should have learned that:
• Flexible code is reusable, generic code that you 

can use in any form module in an application.
• With system variables you can:

– Perform actions conditionally based on current 
location (SYSTEM.CURSOR_[RECORD | ITEM | 
BLOCK])

– Use the value of an item without knowing its name 
(SYSTEM.CURSOR_VALUE)

– Navigate to the initial location after a trigger 
completes: (SYSTEM.TRIGGER_[RECORD | ITEM | 
BLOCK])

– Perform actions conditionally based on commit 
status: SYSTEM.[RECORD | BLOCK | 
FORM]_STATUS
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Summary

• The [GET | SET]_<object>_PROPERTY built-ins are 
useful in flexible coding.

• Code that references objects is more efficient and 
generic:
– By internal ID: Use FIND_<object> built-ins
– Indirectly: Use COPY and NAME_IN built-ins
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Practice 22 Overview

This practices covers the following topics:
• Populating product images only when the image 

item is displayed.
• Modifying the When-Button-Pressed trigger of 

the Image_Button in order to use object IDs 
instead of object names.

• Write generic code to print out the names of the 
blocks in a form.
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Sharing Objects and Code
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe the various methods for reusing objects 

and code
• Inherit properties from property classes
• Group related objects for reuse
• Explain the inheritance symbols in the Property 

Palette
• Reuse objects from an object library
• Reuse PL/SQL code
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Benefits of Reusing Objects and Code

• Increases productivity
• Decreases maintenance
• Increases modularity
• Maintains standards
• Improves application performance
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What Are Property Classes?

LOV

properties

Block

properties

Canvas

properties

Relation

properties

Item

properties
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Creating a Property Class

Add Property Inherit Property

Property ClassDelete Property
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Property palette

Default property

Inheriting from a Property Class

Default property
Default property

Property palette

Default property
Default property

Changed propertyChangeDefault property

Property 
class

Apply

Property palette

Inherited property

Inherited property

Property palette

Inherited property

Inherited property

Variant property
Change

Inherited property
Inherit

Inherited property
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Inheriting from a Property Class

• Set the Subclass Information property.
• Convert an inherited property to a variant 

property.
• Convert a variant property to an inherited 

property.
• Convert a changed property to a default property.

Inherited Property
Variant Property
Default Property

Changed Property
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What Are Object Groups?

Object groups:
• Are logical containers
• Enable you to:

– Group related objects
– Copy multiple objects in one operation
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Creating and Using Object Groups

• Blocks include:
– Items
– Item-level triggers
– Block-level triggers
– Relations

• Object groups cannot include other object groups
• Deleting an object group does not affect the 

objects
• Deleting an object affects the object group
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Copying and Subclassing Objects and Code
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Subclassing

Company Name:
Company Code:
Balance:

Company Name:
Company Code:

Balance:

Address:
Code:

Ability
to inherit
changes

Ability
to add to
child object

Ability
to alter
properties
of child
object

Company Name:
Company Code:

Balance:

Company Name:
Company Code:

Balance:
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What Are Object Libraries?

An Object Library:
• Is a convenient container of objects for reuse
• Simplifies reuse in complex environments
• Supports corporate, project, 

and personal standards
• Simplifies the sharing of 

reusable components
• Is separate from the 

form module
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Benefits of the Object Library

• Simplifies the sharing and reuse of objects
• Provides control and enforcement of standards
• Promotes increased network performance
• Eliminates the need to maintain multiple 

referenced forms
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Working with Object Libraries

Object Libraries:
• Appear in the Navigator if 

they are open
• Are used with a simple 

tabbed interface
• Are populated by 

dragging Form objects to 
tab page

• Are saved to .olb file
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What Is a SmartClass?

• A SmartClass:
– Is an object in an object 

library that is frequently 
used as a class

– Can be applied easily and 
rapidly to existing objects

– Can be defined in many 
object libraries

– Is the preferred method to 
promote similarity among
objects for performance

• You can have many 
SmartClasses of a given 
object type.

Check indicates 
a SmartClass

Check indicates 
a SmartClass
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Working with SmartClasses

1. Right-click an object in 
the Layout Editor or 
Navigator.

2. From the pop-up menu,
select SmartClasses.

3. Select a class from 
the list.
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Reusing PL/SQL

• Triggers:
– Copy and paste text
– Copy and paste within a module
– Copy to or subclass from another module
– Move to an object library

• PL/SQL program units:
– Copy and paste text
– Copy and paste within a module
– Copy to or subclass in another module
– Create a library module
– Move to an object library
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What Are PL/SQL Libraries?

Applications

Form modules
Menu modules
Report modules

.pll file

Procedures

Functions

Packages

Library
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Writing Code for Libraries

• A library is a separate module, holding 
procedures, functions, and packages.

• Direct references to bind variables are not 
allowed.

• Use subprogram parameters for passing bind 
variables.

• Use functions, where appropriate, 
to return values.
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Creating Library Program Units

TEST
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Attach Library Dialog Box
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Calls and Searches

procedure (  );

...function...

package.call (  );
•Program Units

PROCA

PROCB

•Attached Libraries
•Database

Calls

Searches
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Summary

In this lesson, you should have learned that:
• You can reuse objects or code in the following 

ways:
– Property Classes
– Object Groups
– Copying and subclassing
– Object Libraries and SmartClasses

• To inherit properties from a property class, set an 
item’s Subclass Information property.

• You can create an object group in one module to 
make it easy to reuse related objects in other 
modules.
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Summary

• Inheritance symbols in the Property Palette show 
whether the value is changed, inherited, 
overridden, or the default.

• You can drag objects from an object library or 
mark them as SmartClasses for even easier reuse.

• You can reuse PL/SQL code by:
– Copying and pasting in the PL/SQL Editor
– Copying or subclassing
– Defining program units to call the same code at 

multiple places within a module
– Creating PL/SQL library to call the same code from 

multiple forms
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Practice 23 Overview

This practice covers the following topics:
• Creating an object group and using this object 

group in a new form module
• Using property classes
• Creating an object library and using this object 

library in a new form module
• Modifying an object in the object library and 

observing the effect on subclassed objects
• Setting and using SmartClasses
• Creating a PL/SQL program unit to be called from 

multiple triggers
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Using WebUtil to Interact with the Client
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe the benefits of the WebUtil utility
• Integrate WebUtil into a form
• Use WebUtil to interact with a client machine
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WebUtil Overview

WebUtil is a utility that:
• Enables you to provide client-side functionality on 

Win32 clients 

• Consists of:
– Java classes
– Forms objects
– PL/SQL library

Forms
built-Ins

WebUtil
built-Ins
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Benefits of the WebUtil Utility

Why use WebUtil?
• Developer has only to code in PL/SQL (no Java 

knowledge required)
• Free download (part of Forms 10g in a patch set)
• Easy to integrate into a Forms application 
• Extensible
• WebUtil provides:

– Client-server parity APIs
– Client-server added value functions 
– Public functions
– Utility functions
– Internal functions
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Integrating WebUtil into a Form

Library

Step 1:
Attach the 

WEBUTIL library. 
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Integrating WebUtil into a Form

Object
Library

Object
group

Alert

Items

Canvas

Window

Step 2:
Subclass the 

WEBUTIL object group. 
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When to Use WebUtil Functionality

Pre-Form
When-New-Form-Instance

When-New-Block-Instance
(first block)

Form starts
JavaBeans are instantiated

Any trigger after form starts
and while form is running
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Interacting with the Client

Forms Built-Ins / Packages
HOST

GET_FILE_NAME

READ_IMAGE_FILE

WRITE_IMAGE_FILE

OLE2

TEXT_IO

TOOL_ENV

WebUtil Equivalents
CLIENT_HOST

CLIENT_GET_FILE_NAME

CLIENT_IMAGE.READ

(WRITE)_IMAGE_FILE 

CLIENT_OLE2

CLIENT_TEXT_IO

CLIENT_TOOL_ENV
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Example: Opening a File Dialog 
on the Client

DECLARE

v_file VARCHAR2(250):= CLIENT_GET_FILE_NAME('','', 
'Gif Files|*.gif|JPEG Files|*.jpg|',
'Select a photo to upload',open_file,TRUE);



Copyright © 2004, Oracle.  All rights reserved.

Example: Reading an Image File into 
Forms from the Client

DECLARE

v_file VARCHAR2(250):= CLIENT_GET_FILE_NAME('','',
'Gif Files|*.gif|JPEG Files|*.jpg|',
'Select a photo to upload',open_file,TRUE);

it_image_id ITEM := FIND_ITEM
('employee_photos.photo');

BEGIN

CLIENT_IMAGE.READ_IMAGE_FILE(v_file,'',it_image_id);

END;
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Example: Writing Text Files
on the Client

DECLARE

v_dir VARCHAR2(250) := 'c:\temp';

ft_tempfile CLIENT_TEXT_IO.FILE_TYPE;

begin

ft_tempfile := CLIENT_TEXT_IO.FOPEN(v_dir || 

'\tempdir.bat','w');

CLIENT_TEXT_IO.PUT_LINE(ft_tempfile,'dir ' ||     

v_dir || '> '|| v_dir || '\mydir.txt');

CLIENT_TEXT_IO.PUT_LINE(ft_tempfile,

'notepad ' || v_dir || '\mydir.txt');

CLIENT_TEXT_IO.PUT_LINE(ft_tempfile,'del '|| 
v_dir || '\mydir.*');

CLIENT_TEXT_IO.FCLOSE(ft_tempfile);

CLIENT_HOST('cmd /c ' || v_dir || '\tempdir');

END;

1

2

4

3
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DECLARE

v_dir VARCHAR2(250) := 'c:\temp';

ft_tempfile CLIENT_TEXT_IO.FILE_TYPE;

begin

ft_tempfile := CLIENT_TEXT_IO.FOPEN(v_dir || 

'\tempdir.bat','w');

CLIENT_TEXT_IO.PUT_LINE(ft_tempfile,'dir ' ||     

v_dir || '> '|| v_dir || '\mydir.txt');

CLIENT_TEXT_IO.PUT_LINE(ft_tempfile,

'notepad ' || v_dir || '\mydir.txt');

CLIENT_TEXT_IO.PUT_LINE(ft_tempfile,'del '|| 
v_dir || '\mydir.*');

CLIENT_TEXT_IO.FCLOSE(ft_tempfile);

CLIENT_HOST('cmd /c ' || v_dir || '\tempdir');

END;

Example: Executing Operating System 
Commands on the Client
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Example: Performing OLE Automation
on the Client

CLIENT_OLE2.OBJ_TYPE

CLIENT_OLE2.LIST_TYPE

CLIENT_OLE2.CREATE_OBJ

CLIENT_OLE2.SET
_PROPERTY

CLIENT_OLE2.GET_OBJ
_PROPERTY

CLIENT_OLE2.INVOKE_OBJ

CLIENT_OLE2.CREATE
_ARGLIST

CLIENT_OLE2.ADD_ARG

CLIENT_OLE2.INVOKE

CLIENT_OLE2.DESTROY
_ARGLIST

CLIENT_OLE2.RELEASE_OBJ

You can use the following for OLE automation:
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Example: Obtaining Environment 
Information about the Client

CLIENT_TOOL_ENV.GETVAR(:control.env_var,

:control.env_value);
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Summary

In this lesson, you should have learned that:
• WebUtil is a free extensible utility that enables you 

to interact with the client machine
• Although WebUtil uses Java classes, you code in 

PL/SQL
• You integrate WebUtil into a form by attaching its 

PL/SQL library and using an object group from its 
object library; then you can use its functions after 
the form has started and while it is running

• With WebUtil, you can do the following on the 
client machine: open a file dialog box, read and 
write image or text files, execute operating system 
commands, perform OLE automation, and obtain 
information about the client machine
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Practice 24 Overview

This practice covers the following topics:
• Integrating WebUtil with a form
• Using WebUtil functions to:

– Open a file dialog box on the client
– Read an image file from the client into the form
– Obtain the value of a client environment variable
– Create a file on the client
– Open the file on the client with Notepad
– Use OLE automation to create a form letter on the 

client
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Introducing Multiple Form Applications



Copyright © 2004, Oracle. All rights reserved.

Objectives

After completing this lesson, you should be able to do 
the following:
• Call one form from another form module
• Define multiple form functionality
• Share data among open forms
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Multiple Form Applications Overview

• Behavior:
– Flexible navigation between windows
– Single or multiple database connections
– Transactions may span forms, if required
– Commits in order of opening forms, starting with 

current form
• Links:

– Data is exchanged by global variables, parameter 
lists, global record groups, or PL/SQL variables in 
shared libraries

– Code is shared as required, through libraries and 
the database
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Multiple Form Session

Form A

Forms 
Runtime

Global variables
Global record groups

PL/SQL variables

Form B
Open

Form C

Open

Form D

Open

(Parameters)

(Parameters)

(Parameters)
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Benefits of Multiple Form Applications

Breaking your application into multiple forms offers 
the following advantages:
• Easier debugging
• Modularity
• Performance and scalability

Module broken 
into subsets based 
on user navigation

Path 1
(Module 1)

Path 2
(Module 2)
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Starting Another Form Module

MDI

FORM A

MDI

FORM A

Modeless

FORM B
OPEN_FORM

OPEN_FORM
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Defining Multiple Form Functionality

Summit application scenario:
• Run the CUSTOMERS and ORDERS forms in the 

same session, navigating freely between them.
• You can 

make
changes in
the same
transaction
across forms.

• All forms are
visible 
together.
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Defining Multiple Form Functionality

Actions:
1. Define windows and positions for each form.
2. Plan shared data, such as global variables and 

their names.
3. Implement triggers to:

– Open other forms
– Initialize shared data from calling forms
– Use shared data in opened forms
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Conditional Opening

Example

IF  ID_NULL(FIND_FORM(’ORDERS’)) THEN

OPEN_FORM(’ORDERS’);

ELSE  

GO_FORM(’ORDERS’);

END IF;
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Closing the Session

“Will the last one out please turn off the lights?”

Form A

Form B

Run-time
session

Form C
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Closing a Form with EXIT_FORM

• The default functionality is the same as for the 
Exit key.

• The Commit_Mode argument defines action on 
uncommitted changes.

ENTER;

IF  :SYSTEM.FORM_STATUS = ’CHANGED’ THEN 

EXIT_FORM( DO_COMMIT );

ELSE

EXIT_FORM( NO_COMMIT ); 

END IF;
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Other Useful Triggers

Maintain referential links and synchronize data 
between forms:
• In the parent form:

– When-Validate-Item

– When-New-Record-Instance

• In opened forms: When-Create-Record
• In any form: When-Form-Navigate
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Sharing Data Among Modules

You can pass data between modules using:
• Global variables
• Parameter lists
• Global record groups
• PL/SQL package variables in shared libraries



Copyright © 2004, Oracle. All rights reserved.

Linking by Global Variables

ORDERS

Customer_ID
Order

CUSTOMERS

Customer

ID

GLOBAL.CUSTOMERID
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Global Variables: Opening Another Form

Example

Notes
• Control passes immediately to the ORDERS form—

no statements after OPEN_FORM are processed.
• If the Activate_Mode argument is set to 

NO_ACTIVATE, you retain control in the current 
form.

• The transaction continues unless it was explicitly 
committed before.

:GLOBAL.customerid := :CUSTOMERS.customer_id;

OPEN_FORM(’ORDERS’);
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Global Variables: Restricted Query
at Startup

Execute_Query;

:ORDERS.customer_id := :GLOBAL.customerid;

When-New-Form-Instance

Pre-Query
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Assigning Global Variables 
in the Opened Form

• DEFAULT_VALUE ensures the existence of globals.
• You can use globals to communicate that the form 

is running.

DEFAULT_VALUE(’’, ’GLOBAL.customerid’);

Pre-Form example:
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http://myhost:8889/forms90/f90servlet
?form=emp.fmx&otherparams=deptno=140

Linking by Parameter Lists

Parameters:
• Are form module objects
• Properties:

– Name
– Parameter Data Type
– Maximum Length
– Parameter Initial Value

• Can optionally receive a new value:

EMP_FORM 
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Example:
DECLARE

pl_id   ParamList;

pl_name VARCHAR2(10) := 'tempdata';

BEGIN

pl_id := GET_PARAMETER_LIST(pl_name);

IF ID_NULL(pl_id) THEN

pl_id := CREATE_PARAMETER_LIST(pl_name);

ELSE

DELETE_PARAMETER(pl_id,'deptno');

END IF;

ADD_PARAMETER(pl_id,'deptno',TEXT_PARAMETER,
to_char(:departments.department_id));

OPEN_FORM('called_param',ACTIVATE,NO_SESSION,pl_id);

END;

Linking by Parameter Lists

1

2
3
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Linking by Parameter Lists

Example: 
Called form

Create parameter
in the form

IF :parameter.deptno IS NOT NULL THEN
SET_BLOCK_PROPERTY('employees',

DEFAULT_WHERE,'department_id = 
'||:parameter.deptno);

SET_WINDOW_PROPERTY('window1',
TITLE,'Employees in Department  ‘ 
||:parameter.deptno);

END IF;
GO_BLOCK('employees');
EXECUTE_QUERY;

Use parameter name
preceded by :parameter

When-New-Form-Instance Trigger
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Linking by Global Record Groups

1. Create record group with global scope:
DECLARE

rg_name    VARCHAR2(40) := 'LIST'; 
rg_id      RecordGroup;
Error_Flag NUMBER;

BEGIN
rg_id := FIND_GROUP(rg_name);
IF ID_NULL(rg_id) THEN
rg_id := CREATE_GROUP_FROM_QUERY('LIST', 
'Select last_name, to_char(employee_id) 
from employees',GLOBAL_SCOPE); 

END IF;

2. Populate record group:
Error_Flag := POPULATE_GROUP(rg_id);

3. Use record group in any form.
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Linking by Shared PL/SQL Variables

Advantages:
• Use less memory than global variables
• Can be of any data type

To use:
1. Create a PL/SQL library.
2. Create a package specification with variables.
3. Attach the library to multiple forms.
4. Set variable values in calling form.
5. OPEN_FORM with SHARE_LIBRARY_DATA option.
6. Use variables in opened form.
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Linking by Shared PL/SQL Variables

OPEN_FORM(‘called_lib’,ACTIVATE,
NO_SESSION,SHARE_LIBRARY_DATA);
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Summary

In this lesson, you should have learned that:
• OPEN_FORM is the primary method to call one form 

from another form module
• You define multiple form functionality such as:

– Whether all forms run in the same session
– Where the windows appear
– Whether multiple forms should be open at once
– Whether users should be able to navigate among 

open forms
– How data will be shared among forms
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Summary

• You can share data among open forms with:
– Global variables, which span sessions
– Parameter lists, for passing values between specific 

forms
– Record groups created in one form with global 

scope
– PL/SQL variables in shared libraries
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Practice 25 Overview

This practice covers the following topics:
• Using a global variable to link ORDERS and 

CUSTOMERS forms 
• Using built-ins to check whether the ORDERS form 

is running
• Using global variables to restrict a query in the 

ORDERS form
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Introduction to Query Builder
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Query Builder Features

• Easy-to-use data access tool
• Point-and-click graphical user interface
• Distributed data access
• Powerful query building
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Query Builder Features

• Easy-to-use data access tool
• Point-and-click graphical user interface
• Distributed data access
• Powerful query building
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Query Builder Window

2 3

1
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Building a New Query
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Datasource Components

Datasource
name

Object
type

Column
datatype

Recursive
relationship

Comment

Primary Key

Column name

Foreign Key
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Refining a Query
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Sorting Data
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Viewing and Saving Queries
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Including Additional Tables
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Viewing Comments
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Including Related Tables
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Creating a User-Defined Relationship
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Unmatched Rows
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Conditions
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Operators

Arithmetic
• Perform calculations on numeric and date 

columns
• Examples: +, -, x, /

Logical
• Combine conditions
• Examples: AND, OR, NOT

Comparison
• Compare one expression with another
• Examples: =, <>, <, IN, IS NULL, 

BETWEEN ... AND
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Multiple Conditions
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Deactivating a Condition
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Defining Columns Using an Expression
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Defining Columns Using a Function
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Locking in Forms
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Objectives

After completing this lesson, you should be able to do 
the following:
• Identify the locking mechanisms in Forms
• Write triggers to invoke or intercept the locking 

process
• Plan trigger code to minimize overheads

on locking
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Locking

Table in (RX)

Row in (X)

Row in (X)

Insert, update, or delete

Insert, update, or delete

Query
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Default Locking in Forms

Insert record

Update record

Delete record

SaveAction

No locks

RS on table

RS on table

RX on above
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Concurrent Updates and Deletes

• When users compete for the same record, normal 
locking protection applies.

• Forms tells the operator if another user has 
already locked the record.
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User A: Step 1
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User B: Step 2
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User A: Step 3
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User B: Step 4
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Locking in Triggers

Achieved by:
• SQL data manipulation language
• SQL explicit locking statements
• Built-in subprograms
• DML statements
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Locking with Built-Ins

• ENTER_QUERY (FOR_UPDATE)
• EXECUTE_QUERY (FOR_UPDATE)
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On-Lock Trigger

Example

IF USER = 'MANAGER' THEN

LOCK_RECORD;

ELSE

MESSAGE('You are not authorized to change 

records here');    

RAISE form_trigger_failure;

END IF;
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Summary

• Default locking 
– Locks rows during update and delete
– Informs user of concurrent update and delete

• Locking in triggers 
– Use SQL and certain built-ins
– On-Lock trigger: LOCK_RECORD built-in available
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Oracle Object Features
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Objectives

After completing this lesson, you should be able to do 
the following:
• Describe the Oracle scalar datatypes
• Describe object types and objects
• Describe object tables, object columns, and object 

views
• Describe the INSTEAD-OF triggers
• Describe object REFs
• Identify the display of objects in the Object 

Navigator
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Oracle Scalar Datatypes

• Automatically converted:
– FLOAT
– NLS types

NCHAR
NVARCHAR2

• Unsupported:
– Timestamp
– Interval



Copyright © 2004, Oracle. All rights reserved.

Object Types

Attributes

po_no
custinfo

line_items
amount

Methods

Ship

Cancel

Hold

Check status

ORDER
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Object Tables

Object table based on object type
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Object Columns

Object column based on object type
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Object Views

Object views based on object types

Object
view

Object-oriented 
application

Relational
table
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INSTEAD-OF Triggers

INSTEAD-OF 
Trigger

Nonupdatable 
view

DECLARE

BEGIN

EXCEPTION

END;
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References to Objects

OID

REF
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Object Types in Object Navigator
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Object Type Wizard 
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Object Tables and Columns 
in Object Navigator
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Object Views in Object Navigator
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INSTEAD-OF Trigger Dialog Box
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Object REFs in Object Navigator
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Summary

• Oracle8 introduced three scalar datatypes.
• Objects and object types allow representation of 

complex data.
• Three kinds of objects are object tables, object 

columns, and object views.
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Summary

• INSTEAD-OF triggers allow DML on object views.
• Object REFs store the object identifier of certain 

types of objects.
• The Object Navigator can display certain types of 

objects.
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Using the Layout Editor
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Objectives

After completing this lesson, you should be able to do 
the following:
• Control the position and size of objects in a layout
• Add lines and geometric shapes
• Define the colors and fonts used for text
• Color the body and boundaries of objects
• Import images onto the layout
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Using the Layout Editor

Common features:
• Moving and resizing objects and text
• Defining colors and fonts
• Importing and manipulating images and drawings
• Creating geometric lines and shapes
• Layout surface: Forms canvas view
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Invoking the Layout Editor
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Layout Editor: Components

1
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Layout Editor: Components

2

5

3

4

6

9

8 7
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Tool Palette

1

2

3

5

6

7

8

9

10

11

12

13

4
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Selecting Objects
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Manipulating Objects

Expand/contract
in one direction

Expand/contract
diagonally



Copyright © 2004, Oracle. All rights reserved.

Moving, Aligning, and Overlapping
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Groups in the Layout

• Groups allow several objects to be repeatedly 
treated as one.

• Groups can be colored, moved, or resized.
• Tool-specific operations exist for groups.
• Groups have a single set of selection handles.
• Members can be added or removed.
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Edit and Layout Menus
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Color and Pattern Tools

2
3

1

4
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Importing Images
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Summary

• You can create objects by:
– Choosing a palette tool
– Clicking and dragging on a layout region

• There are color palette tools for fill area, lines, and 
text.

• View, Edit, and Layout menus display additional 
options for layout.

• Objects can be grouped for operations.
• You can import images by using Edit > Import.
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